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Zusammenfassung

Zusammenfassung

Durch Starkregen verursachte pluviale Hochwasserereignisse stellen in Zeiten, in denen bedingt

durch den Klimawandel mit einer stetigen Zunahme von Wetterextremen zu rechnen ist, eine

immer bedeutender werdende Naturgefahr dar. Modellierungen und Simulationen von Starkre-

genereignissen sind ein wertvolles Mittel, um den Ablauf solcher Ereignisse besser verstehen

und gefährdete Bereiche besser schützen zu können. 

Ein wesentlicher Einflussfaktor bei der Modellbildung ist die im Untersuchungsraum vorhande-

ne Landnutzung. Frei verfügbare Satellitendaten in guter räumlicher Auflösung stellen dabei

aufgrund ihrer ständigen Aktualität eine äußerst wertvolle Quelle dar.

Die vorliegende Arbeit zeigt, dass alle Schritte, die für die Entwicklung eines Datenmodells zur

Identifizierung pluvialer Überschwemmungsgebiete erforderlich sind, vollständig  in einer inte-

grierten  GIS-Arbeitsumgebung  (hier  ESRI  ArcMap 10.6)  durchgeführt  werden können.  Die

Schritte umfassen die systematische Datenbeschaffung von Sentinel-2A-Satellitenbildern mit

integrierten Download-Tools, die Bildklassifizierung zur Ermittlung der Landnutzung, die Auf-

bereitung und Geoprozessierung aller für die Modellbildung benötigten Ausgangsdaten mittels

vorhandener Geoverarbeitungs-Werkzeuge und selbst programmierter Python-Skript-Werkzeu-

ge, die (Teil-)Automatisierung der einzelnen Geoverarbeitungsschritte mittels ModelBuilder so-

wie die Berechnung der Überschwemmungsgebiete mit der komplett in ArcMap integrierbaren

Anwendung FloodArea. Durch die Wahl von möglichst allgemein verfügbaren und lokal unab-

hängigen  Ausgangsdaten  (Sentinel-2-Daten  für  Landnutzung,  Inca-Radardaten  für  Nieder-

schlag, Globaldaten hydrologischer Bodengruppen) soll erreicht werden, dass das Datenmodell

möglichst variabel und raumübergreifend einsetzbar ist.

Als Untersuchungsraum für die Modellierung wird das ca. 6 km² große Einzugsgebiet Koppl

im österreichischen Salzkammergut  gewählt,  modelliert  wird das  Starkregenereignis  vom 8.

Juni 2018 mit maximalen Niederschlagsmengen von über 40 mm pro m² und pro Stunde. Die

Ergebnisse  der  Modellierung  zeigen  deutlich  die  bevorzugten  Abflussbahnen  der  pluvialen

Hochwasserströme. Neben natürlichen Gräben und Senken dienen vor allem auch Straßen als

Abflussbahnen.  Der Einfluss von versiegelten Oberflächen auf den direkten Abfluss wird durch

ein Modell-Szenario mit fiktiven Neuversiegelungen verdeutlicht. Es zeigt sich, dass von zu-

sätzlichen Versiegelungen vor allem die Unterlieger betroffen sind. 

Aufgrund der Prämisse der einfachen Übertragbarkeit des Modells wird auf die Eingabe von

Fließhindernissen und Entwässerungssystemen verzichtet, was bei der Aussagekraft der Model-

lergebnisse  berücksichtigt  werden  muss.  Das  entwickelte  Datenmodell  kann  demnach  als

Grundgerüst verstanden werden, das für nahezu jedes Einzugsgebiet eine erste grobe Einschät-

zung pluvialer Überschwemmungsbereiche erlaubt. Je nach Zielrichtung der Modellierung und

je nach Verfügbarkeit von Daten und Informationen im EZG kann das Datenmodell weiterent-

wickelt, ergänzt und modifiziert werden, um besser an die reale Situation angepasst zu werden.

Schlagwörter: Starkregen, pluviale Überschwemmung, Hochwasser, Sentinel-2, Inca-Radar,     
Curve-Number, ArcGIS, Python, ModelBuilder, FloodArea
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Einleitung

1.  Einleitung

1.1  Pluviale vs. fluviale Hochwasserereignisse

Als Folge des Klimawandels ist in den kommenden Jahren weltweit mit einer Zunahme von

Wetterextremen zu rechnen (IPCC 2014). Dazu zählen auch lokale Starkregenereignisse, deren

Zunahme sich bereits heute in den Trends statistischer Zeitreihendaten ablesen lässt  (KLIWA

2016). Dass die Gefahren, die solche Starkregenereignisse bergen, im Bewusstsein von Behör-

den und Entscheidungsträgern angekommen sind, zeigt sich beispielsweise in der EU-Richtlinie

2007/60/EG über die Bewertung und das Management von Hochwasserrisiken für die menschli-

che Gesundheit, die Umwelt, das Kulturerbe und die wirtschaftliche Tätigkeit. Was die Art der

Überflutungstypen anbelangt,  werden neben den Überflutungen entlang von Gewässern und

Entwässerungssystemen  (fluviales  Hochwasser)  auch  die  Überflutungen  genannt,  die  direkt

durch Niederschläge verursacht werden (EU 2007). 

Gemäß dem zugehörigen Leitfaden für die Berichterstattung im Rahmen der Hochwasserrichtli -

nie werden pluviale Hochwasserereignisse definiert als Überschwemmung von Landflächen di-

rekt aus Niederschlagswasser, das auf diese fällt bzw. darüber abfließt. Als Ursache inbegriffen

sind  hierbei  Starkregen,  Oberflächenwasser,  Hangwasser  und  direkter  Abfluss  aus  Schnee-

schmelze (EU 2013). Falconer et al. (2009) definieren pluviale Hochwasserereignisse als „Über-

flutungen,  die  aus  niederschlagsgenerierten  Oberflächenabflüssen  und  -überflutungen  verur-

sacht werden, bevor der Abfluss ein Fließgewässer oder ein Entwässerungssystem erreicht, oder

nicht in dieses Netzwerk fließen kann, da seine Kapazitätsgrenzen erreicht sind.“ Ein pluviales

Hochwasserereignis kann demnach fernab von Gewässern auftreten und zeichnet sich dadurch

aus, dass aus einem Niederschlagsereignis direkt Oberflächenabfluss entsteht, was zu Überflu-

tungen führt, ohne dass dabei ein über die Ufer tretendes Fließgewässer involviert sein muss. 

In besiedelten Gebieten mit  hohem Versiegelungsgrad gehen solche Hochwasserwellen zum

Teil  als  urbane Sturzfluten nieder,  wobei  Siedlungsgebiete in Hanglage besonders gefährdet

sind, da diese zum Teil zusätzlichen Oberflächenabfluss von umliegenden landwirtschaftlich ge-

nutzten Flächen erhalten. Bei lokalen Überschwemmungen spielt zusätzlich oft eine kurzzeitige

Überlastung der Siedlungsentwässerungssysteme eine Rolle (Tyrna und Hochschild 2010). Aus

wirtschaftlichen  Gründen  werden  die  Siedlungsentwässerungssysteme  auf  häufigere  Nieder-

schlagsereignisse ausgerichtet, d.h. auf Niederschlagsabflüsse mit 1- bis 10-jährlicher Wieder-

kehrrate (für Bayern vgl. dazu bspw.  LfU 2009, für Österreich bspw.  Zahnt et al. 2017). Bei

Starkregenereignissen mit so hohen Niederschlagsintensitäten, dass Oberflächenabfluss im Sin-

ne einer Hochwasserwelle entsteht, kann demnach von einer maximalen Auslastung bzw. Über-

lastung der urbanen Entwässerungssysteme ausgegangen werden, so dass von diesen Systemen

bereits nach kurzer Zeit kein Wasser mehr aufgenommen oder gepuffert werden kann. Bei der

späteren Modellierung wird auf diesen Sachverhalt noch einmal detaillierter eingegangen. 

In Abgrenzung zur bisherigen Definition sollen in der vorliegenden Arbeit diejenigen urbanen

oberflächlichen Abflüsse nicht unter den Begriff des pluvialen Hochwassers gerechnet werden,

die sich vorwiegend aus einer Disfunktionalität der Entwässerungssysteme ergeben, beispiels-

weise verursacht durch Kanalrückstau oder die Überlastung von Regenrückhaltebecken, verur-

1



Einleitung

sacht z.B. durch längere Regenperioden in Kombination mit hohen Grundwasserständen. Das

Auftreten eines lokalen und zeitlich eng begrenzten (im Bereich mehrerer Stunden stattfinden-

den) Starkregenereignisses wird im Folgenden als  implizite Voraussetzung für  ein pluviales

Hochwasserereignis gesehen.

Während im Umfeld von Fließgewässern vor allem langanhaltende Gebietsniederschläge groß-

räumiger Tiefdruckgebiete für Hochwassergefahr sorgen, liegt die Ursache für pluviale Überflu-

tungen – wie sie für die vorliegende Arbeit definiert sind – vor allem bei kleinräumigen konvek-

tiven Niederschlagszellen, die sich in kurzer Zeit mit großen Niederschlagshöhen und -intensitä-

ten entladen. Vorausgehende moderate aber langanhaltende Niederschläge und lokale Grund-

wasserhöchststände können dabei den „Nährboden“ für ein pluviales Hochwasserereignis bilden

oder dessen Auswirkungen verstärken (Zahnt et al. 2017). Großflächige – oft unnötige – Versie-

gelung der Oberfläche im Zusammenspiel mit mangelhaften oder überforderten Entwässerungs-

systemen und unzureichend geplanten Regenwasserrückhaltesystemen erhöhen die Anfälligkeit

von Siedlungsgebieten gegenüber Starkregenüberflutungen (Apreda 2016).

In Österreich steigt die Versiegelung von Flächen und die Erweiterung von Siedlungen in bisher

freien, oft landwirtschaftlich genutzten Gebieten stetig an. Viele Siedlungserweiterungen finden

nicht nur in exponierten Tallagen statt, sondern auch Hanglagen werden immer mehr genutzt.

Das Gefahrenbewusstsein für ein pluviales Hochwasser ist bei den Bewohnern aber in den meis-

ten Fällen – oft alleine aufgrund der entfernten Lage zu einem Fließgewässer –  nicht vorhanden

(Zahnt et al. 2017).

1.2  Forschungsüberblick

Während für fluviale Hochwasser in vielen Regionen bereits landesweite Gefahrenkarten erar-

beitet  worden sind  (z.B.  im Rahmen  der  EU-„Hochwasserrisikomanagement-Richtlinie“  EU

2007), fehlen bisher flächendeckende Gefahren- und Risikokarten für den Typus des pluvialen

Hochwasserereignisses (Kaspersen et al. 2015). So sind beispielsweise im Nationalen Hochwas-

serrisikomanagementplan  des  österreichischen Bundesministeriums  für  Land-  und Forstwirt-

schaft, Umwelt und Wasserwirtschaft (RMP) von 2015 alle Arten von Hochwasser berücksich-

tigt,  die  als  signifikante  Hochwasserprozesse  identifiziert  sind.  Dabei  werden auch pluviale

Hochwässer behandelt, allerdings sind aufgrund der fehlenden Datengrundlage keine Gebiete

mit potenziellem signifikanten Hochwasserrisiko für rein pluviale Ereignisse erfasst  (Zahnt et

al. 2017).

Die Gründe liegen zum einen darin, dass es sich bei pluvialen Hochwasserereignissen um ein

Phänomen handelt, dessen Gefahren- und Schadenspotenzial erst in jüngerer Zeit vermehrt Auf-

merksamkeit gewidmet worden ist, zum anderen darin, dass zunächst verschiedene Ansätze zur

Modellierung von Sturzfluten entwickelt und im Rahmen von Fallstudien in unterschiedlichen

Natur- und Siedlungsräumen erprobt werden müssen, bevor flächendeckend nach einheitlicher

Methodik vergleichbare Karten erstellt werden können (Tyrna und Hochschild 2010). Während

Modelle zur Risikoabschätzung fluvialer Hochwässer seit längerem vorliegen und dementspre-

chend an einer Vielzahl von Fallstudien erprobt und verifiziert werden konnten, steht die Mo-

dellierung pluvialer Hochwasserereignisse noch am Anfang (Scheid et al. 2013). Dementspre-

chend werden verschiedene Modellierungsansätze anhand einzelner Szenarien bzw. Fallstudien

auf ihre Anwendbarkeit und Ergebnisgüte getestet.  
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Von Mai 2005 bis Dezember 2008 wurden in dem vom deutschen Bundesministerium für For-

schung geförderten Vorhaben URBAS „Vorhersage und Management von Sturzfluten in urba-

nen Gebieten“ unter Beteiligung von verschiedenen Projektbeteiligten (u.a. aus den Bereichen

Wasserwirtschaft, Meteorologie, Ingenieurwissenschaft) deutschlandweit Fallstudien durchge-

führt, um die Kenntnisse über den Ereignistyp „Überflutung durch Starkniederschlag“ zu ver-

bessern und darauf aufbauend Handlungsvorschläge zu erarbeiten für Vorsorge und Schutzmaß-

nahmen, Vorhersagemöglichkeiten und Warnsysteme und den Katastrophenschutz im Ereignis-

fall. Zur Modellierung der Abflüsse wurde größtenteils auf das 2D-Modell Hydro_AS_2D zu-

rückgegriffen (Hydrotec et al. 2008). Tyrna und Hochschild (2010) erzielten in einer Fallstudie

zur Modellierung von lokalen Überschwemmungen nach Starkniederschlägen im Baden-Würt-

tembergischen Ort Jungingen gute Ergebnisse mit  dem Open-Source-Modell r.sim.water und

verweisen gleichzeitig – je nach Verfügbarkeit der Ausgangsdaten – auf die ebenfalls gute Ver-

wendbarkeit von FloodArea oder Hydro_AS_2D. Kaspersen et al. (2015) führten für Ihre Ana-

lyse zum Einfluss von städtischer Versiegelung und Klimawandel auf die Gefährdung europäi-

scher Städte für pluviale Überflutungen Modellierungen in der dänischen Stadt Odense mit dem

hydrodynamischen 2D-Modell MIKE FLOOD durch, Di Salvo et al. (2017) nutzten für Ihre Un-

tersuchung  von  pluvialen  Hochwasserereignbissen  in  Rom  einen  GIS-basierten  Ansatz  mit

QGIS, ArcMap und ArcHydro.

Für eine konkrete quantitative Schadens-Abschätzung durch Überflutungen auf räumlicher Ge-

bäude-Auflösung haben Neubert et al. (2016) erfolgreich das GIS-basierte Schaden-Simulati-

onsmodell HOWAD eingesetzt, das sich gegenüber anderen Modellen vor allem in Hinblick auf

die hohe räumliche Auflösung und durch gute Anpassungsfähigkeit bzw. Aktualisierbarkeit aus-

zeichnet.  Dies sei aber nur in Hinblick auf weiterführende Studien erwähnt, da die konkrete

Schadensabschätzung nicht Gegenstand der vorliegenden Arbeit ist.

Für die Abflussmodellierung kann also grundsätzlich auf etablierte Modelle zurückgegriffen

werden. Die gewählten Bespiele stehen exemplarisch für die zwei grundsätzlichen Ansätze der

Hochwassermodellierung: hydrodynamische numerische Modelle und GIS-basierte Modelle. 

In hydrodynamischen Modellen wird die Berechnung des Outputs anhand eines Rasters oder ei-

nes flexiblen Gitters durchgeführt, was die Möglichkeit bietet, auch kleinräumige Abflusspro-

zesse (beispielsweise abrupte Änderungen in Fließgeschwindigkeit und Fließrichtung) besser

abzubilden. Durch eine gesonderte Aufbereitung des Digitalen Geländemodells  ist  es zudem

möglich, den Abfluss auch zwischen Häusern zu generieren. Zudem ist es bei den meisten Mo-

dellen möglich, räumlich und zeitlich variable Niederschlagsdaten als Input zu verwenden. Ei-

nen wichtigen Faktor stellt die Berücksichtigung des Kanalnetzes dar, das oft als 1D-Modell in

die 2D-Modellierung integriert werden kann. Der Abfluss in das Kanalnetz oder Überstau aus

der Kanalisation stellen wichtige Prozesse bei der Modellierung von Starkregenereignissen im

urbanen Raum dar  (Hydrotec et al. 2008). Der Nachteil von hydrodynamischen Modellen be-

steht neben der mitunter sehr langen Rechenzeiten darin, dass sie oftmals eine Fülle an sehr de-

taillierten Ausgangsdaten benötigen, die im Rahmen einer großräumigen oder gar flächende-

ckenden Analyse nicht zur Verfügung stehen oder nur unter immensem organisatorischen, zeit-

lichen und monetären Aufwand beschafft werden könnten. Erforderliche Input-Daten zu Relief,

Hangneigung und Oberflächenbeschaffenheit  werden oftmals  mit  Hilfe  einer  GIS-gestützten

Geländeanalyse auf- bzw. vorbereitet.
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Die Analyse des digitalen Geländemodells (DGM) und die Ableitung hydrologisch relevanter

Parameter mit einem GIS stellt einen wesentlichen Faktor dar, um gefährdete Geländesenken

und Hauptfließwege eines Hochwassers identifizieren zu können. Wird der Oberflächenabfluss

mit einem GIS-basierten Modell berechnet, bietet das den Vorteil, dass von der Bereitstellung

der Basisdaten über die Aufbereitung der Daten für das Rechenmodell bis hin zur kartographi-

schen Auswertung der Ergebnisse alle Schritte integriert im GIS erfolgen können, ohne dass

Schnittstellen mit anderer Software berücksichtigt werden müssen (Di Salvo et al. 2017, Zhang

und Pan 2014). Durch die vereinfachten Modellansätze bei einer GIS-basierten Berechnung des

Oberflächenabflusses können allerdings nicht alle physikalischen Prozesse wie Impulserhaltung

oder die Berücksichtigung von hydrostatischen Kräften abgebildet werden, ebenso wenig die

detaillierte Rückkopplung mit dem Kanalnetz. Als Berechnungsgrundlage dient immer ein Ras-

ter. In kleinräumigen Bereichen, oder wenn eine extrem hohe Detailschärfe des Outputs gefor-

dert ist, ergeben sich somit Nachteile gegenüber den hydrodynamischen Modellen.

Die Wahl des geeigneten Abflussmodells ist letztendlich abhängig von der verfügbaren Daten-

grundlage, der Aufgabenstellung (z.B. hinsichtlich des zu betrachtenden Untersuchungsraums)

und den Anforderungen an den Ergebnis-Outputs hinsichtlich der Ausgabe-Parameter und der

Detailschärfe.  

Wichtig für einen systematischen Ansatz zur Modellierung pluvialer Hochwasserereignisse sind

neben der Abflussmodellierung geeignete Daten für die Modellierung der Erdoberfläche, die ge-

rade in Hinblick auf Oberflächenrauigkeit  und Versiegelungsgrad einen entscheidenden Ein-

flussfaktor für die Entstehung der urbanen Sturzfluten darstellt (Kaspersen et al. 2015). 

Was die Modellierung der Erdoberfläche in Form der Landbedeckung und Landnutzung angeht,

wird bei bisherigen Analysen oft auf behördlich bereitgestellte Daten zur Landnutzung zurück-

gegriffen, beispielsweise auf regional erhobene Daten  (Di Salvo et al. 2017) oder – exempla-

risch für Deutschland – auf das staatliche ALKIS/ATKIS-Modell (Tyrna und Hochschild 2010).

Staatliche Daten haben den Vorteil, dass sie flächendeckend verfügbar sind und nach einheitli -

chen Standards erfasst sowie in einer einheitlichen und transparenten Geodatenstruktur gespei -

chert und bereitgestellt werden. Informationen über die Daten werden in Metadaten zur Verfü-

gung gestellt (AdV 2015). Nachteilig ist jedoch, dass die Datenbestände nur in längeren Zeitab-

ständen (meist mehrere Jahre) aktualisiert werden können und dass kein Einfluss auf die Eintei-

lung bzw. Definition der Landnutzungs- und Landbedeckungsklassen genommen werden kann. 

Bei einem Vergleich verschiedener Datentypen zur Modellierung der Geländerauigkeit identifi-

zieren Dorn et al. (2014)  neben LiDAR-Daten für das digitale Geländemodell vor allem Daten

aus OpenStreetMap (OSM) für die Landnutzung, da diese eine hohe Aktualität aufweisen. Al-

lerdings liegen aktuelle OSM-Daten nicht flächendeckend vor, so dass fallspezifisch je nach

Untersuchungsraum entschieden werden muss, ob die verfügbaren Daten ausreichend als Daten-

basis für ein Abflussmodell geeignet sind.

Für flächendeckend aktuelle und kontinuierlich aktualisierbare Daten zur Landbedeckung und

Landnutzung eröffnen Satellitendaten zunehmend neue Möglichkeiten, da sie in immer besserer

zeitlicher und räumlicher Auflösung und oft kostenlos (z.B. Sentinel-2 oder LandSat-8) öffent-

lich zur Verfügung stehen (Labib und Harris 2018). 

Das wichtigste Werkzeug zur Extraktion von Landnutzungs-Informationen aus Satellitenbildern

stellte lange Zeit die pixelbasierte Klassifizierung dar, in Form von unüberwachter oder über-
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wachter  Klassifizierungsmethode  unter  Einbezug  von  Trainingsgebieten.  Mit  zunehmender

räumlicher  Auflösung  der  Fernerkundungsdaten  kam  dann  der  objektbasierten  Bildanalyse

(OBIA) immer größere Bedeutung bei der Klassifizierung von Oberflächenelementen zu, da sie

in der Lage ist, neben den reinen Pixelwerten auch Kontextinformationen zu berücksichtigen,

und sie nachweislich bessere Ergebnisse erzielen kann als die alternativ angewandte per-Pi-

xel-Analyse (Myint et al. 2011). Gerade in Hinblick auf die Extraktion von Landnutzungsklas-

sen sind auf diesem Gebiet in jüngster Zeit verstärkt Verfahren entwickelt worden, um die Ge-

nauigkeit zu verbessern. So erzielten Labib und Harris (2018) gute Ergebnisse mit Sentinel 2-

Daten bei der Identifikation von Grünstrukturen im Siedlungsbereich oder  Kaplan und Avdan

(2017) bei der Bestimmung von Wasserflächen. Die Wahl von OBIA ggü. der pixelbasierten

Bildanalyse wird bei letzteren vor allem damit begründet, dass die pixelbasierte Analyse grund-

sätzlich  größere  Ungenauigkeiten  in  gebirgigen  und  städtischen  Gebieten  liefert,  sowie  bei

Schnee- und Wolkenbedeckung. Einen umfassenden Überblick über die Nutzung von Satelliten-

daten zur Ableitung von Landnutzungs- und Landbedeckungsklassen und speziell hinsichtlich

der Entwicklung von objektbasierten Klassifizierungsmethoden im Vergleich zur pixelbasierten

Klassifizierung liefert  Blaschke (2010) in seiner sehr ausführlichen Analyse der bis dato er-

schienenen wissenschaftlicher Literatur. Mit der „geographischen objektbasierten Bildanalyse

(Geographic Object Based Imaged Analysis, GEOBIA)“ wird von  (Blaschke et al. 2014) ein

Ansatz beleuchtet, der auf der OBIA aufbauend einen besonderen Fokus auf GIS-Funktionalitä-

ten lenkt und es z.B. ermöglicht, bei der Bild-Klassifizierung auch das Segment umgebende In-

formationen mit einzubeziehen.

Eine Alternative zur Verwendung optischer Sensordaten zur Identifizierung versiegelter Ober-

flächen liefern Zhan et al. (2018) mit der Vorstellung einer neuen Klassifizierungsmethode ba-

sierend auf SAR-Daten. Unter anderem stellt dabei zwar die Identifizierung von Vegetation mit

polimetrischen SAR-Daten eine große Herausforderung dar, insgesamt stellt das Verfahren aber

eine Alternative mit großem Potenzial dar.

Schließlich erfordern hydrologische Modelle – gerade für kleinräumige Analysen wie bei pluvi-

alen Hochwasserereignissen – Niederschlagsinformationen in hoher räumlicher und zeitlicher

Auflösung. Bis heute bilden meist Regenschreiber die Grundlage für wasserwirtschaftliche Ana-

lysen und Planungen. Die terrestrischen Punktmessungen an einer bestimmten (Wetter-) Station

bieten in der Regel langjährige Daten der Niederschlagserfassung mit einer hohen Genauigkeit

vor Ort. Ihr Nachteil liegt allerdings in der  räumlich begrenzten Aussagefähigkeit der Daten.

Da  Radardaten  eine  quantitative  und  qualitative  Wiedergabe  der  flächendeckenden  Nieder-

schlagsverteilung ermöglichen, stellen sie eine ideale Datenquelle für raumbezogene Analysen

des  Regengeschehens  dar.  Auch  bei  einem  dichten  Messnetzes  von  terrestrischen  Nieder-

schlagsstationen  ist  die  Verortung  kleinräumiger  Niederschlagszellen,  die  sich  bei  heftigen

Starkregen oft sehr lokal bilden, häufig nur durch die Analyse von Radarniederschlagsdaten

möglich  (Treis et al. 2017). Zudem bieten Radardaten neben der hohen räumlichen auch eine

hohe zeitliche Auflösung des Intensitätsverlaufes (Bronstert et al. 2017). 

Der gewichtigste Nachteil der Radar-Niederchlagsdaten liegt darin, dass es sich um indirekte

Messungen handelt. Mit zunehmendem Abstand zwischen der Radarstation als Messpunkt und

dem betrachteten Untersuchungsraum für den Niederschlag (Einzugsgebiet) nimmt die Genau-

igkeit der Niederschlagsmessungen ab.  Niemi et al.  (2017) bestätigen aus diesem Grund die

Wichtigkeit  von lokalen  terrestrischen Messungen für  hydrologische  Analysen,  konstatieren
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aber gleichzeitig, dass mit Radardaten in zeitlicher Auflösung von 5 Minuten und räumlicher

Auflösung von 1 km² durchaus akzeptable Ergebnisse bei der Niederschlags-Abfluss-Modellie-

rung erzielt werden konnten. Eine Übersicht über die wichtigsten Vor- und Nachteile der Ver-

wendung von Radardaten für hydrologische Analysen liefern Berne und Krajewski (2013).

1.3  Zielsetzung: GIS-basiertes Datenmodell zur Identifizierung plu-
vialer Überschwemmungsgebiete

Wie bereits ausgeführt, liegt ein Vorteil der GIS-basierten Hochwassermodellierung im integra-

tiven Ansatz. Hauptziel der vorliegenden Arbeit ist es, diesen integrativen Ansatz zu erweitern

und ein Datenmodell  zu entwickeln,  das  es  ermöglicht,  die Abschätzung von Überschwem-

mungsgebieten pluvialer Hochwasserereignisse auf Grundlage aktueller und kontinuierlich zur

Verfügung stehender Daten vollständig und weitgehend automatisiert in einem GIS durchzufüh-

ren. Anhand zweier Szenarien soll dabei aufgezeigt werden, wie sich die Zunahme versiegelter

Flächen in Siedlungsgebieten auf die Ausprägung der Überschwemmungsbereiche auswirkt.

Die Auswahl der Daten und die Entwicklung des Datenmodells erfolgen in dieser Arbeit nach

dem Grundsatz, dass die Basisdaten möglichst flächendeckend verfügbar sein sollen und die Be-

arbeitungsmethoden möglichst raumübergreifend anwendbar sein sollen. Dadurch soll das Mo-

dell möglichst gut auf verschiedene Regionen anwendbar sein. Gewisse Restriktionen bei der

räumlichen Auflösung der Daten und Nicht-Beachtung bzw. Verallgemeinerung von lokalen

Spezifika werden dafür bewusst in Kauf genommen.

Die Identifizierung von Landnutzung bzw. Landbedeckung aus Sentinel  2A-Satellitenbildern

wird nicht mit einer Spezialsoftware wie eCognition oder Erdas Imagine durchgeführt, sondern

in der Arbeitsumgebung von ArcMap. Zum Einsatz kommt dabei zum einen ein integrierbares

Tool  zur  Abfrage  und zum Download von Sentinel  2-Bildern,  zum anderen  das  integrierte

Werkzeug „Bildklassifizierung“, das einer interaktiven und überwachten pixelbasierten Klassifi-

zierungsmethode entspricht. Dem Faktor eines GIS-integrierten Werkzeugs wird hier also im

Vergleich zur eigtl. aktuell vorherrschenden Tendenz zur OBIA bewusst der Vorrang einge-

räumt. Ein Teilziel der Arbeit besteht demnach in der Überprüfung, ob die in einem GIS mit

Hilfe einer relativ einfachen Klassifizierungsmethode aus Sentinel 2-Bildern ermittelten Daten

zur Landnutzung den qualitativen Erfordernissen für eine nachfolgende Hochwassermodellie-

rung genügen.

Die Aufbereitung von Radardaten zur Erfassung des Niederschlags erfolgt mit Hilfe eines ei-

gens entwickelten Python-Skriptes, das sich als Python-Skript-Werkzeug problemlos in die Arc-

Map-Arbeitsumgebung  integrieren  lässt,  die  Automatisierung  von  Teilprozessen  erfolgt  mit

dem ArcMap-ModelBuilder, die Hochwassersimulation selbst wird mit  der in ArcAMp inte-

grierbaren Software FloodArea durchgeführt. Die komplette Datenaufbereitung und -integration

der Modell-Ausgangsdaten (DGM, Landnutzung, Niederschlag etc.) sowie die Hochwassersi-

mulation erfolgen demnach in der Arbeitsumgebung ESRI ArcMap (Version 10.6.). 

Das Ergebnis der Modellierung besteht in der Darstellung von Übersichtskarten zur Identifizie-

rung von (Siedlungs-)Bereichen,  die  bei  einem pluvialen Hochwasserereignis potenziell  von

Überflutungen betroffen sind, vergleichbar zu den Hochwassergefahrenkarten für ein fluviales

Hochwasserereignis. Die Gefährdungsabschätzung bestimmter Gebäudeteile oder die Ableitung

6



Einleitung

konkreter Vorsorge- und Schutzmaßnahmen sind nicht Ziel der Arbeit. Das entwickelte Daten-

modell kann aber als Grundlage für solche weitergehenden Analysen betrachtet werden. 

Zusammenfassend ist das Hauptziel der Arbeit die Entwicklung eines Datenmodells zur Identi-

fizierung pluvialer Überschwemmungsgebiete mit den Teilzielen, dass dieses Datenmodell aus-

schließlich GIS-basiert ist und aufgrund der verwendeten Basisdaten möglichst raumübergrei-

fend übertragbar und anwendbar ist.
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2.  Hydrogeographische Grundlagen und deren Einfluss auf die
gewählte Methodik

2.1  Allgemeine Prozesse und Faktoren der Abflussbildung

Das gesamte Wasser, das sich als Abfluss in einem Fließgewässer wiederfindet, hat seinen Ur-

sprung im Niederschlag, wobei es zwischenzeitlich in Form von Schnee und Eis, in Seen, als

Bodenwasser oder als Grundwasser gespeichert gewesen sein kann (Baumgartner und Liebscher

1996). Der Abflussprozess kann in drei Vorgänge untergliedert werden, wie sie in Abbildung 1

schematisch dargestellt sind.

Abbildung 1: Schematische Darstellung des Abflussprozesses

Quelle: Leicht verändert nach Baumgartner, Liebscher 1996.

Beim Prozess der Abflussbildung entsteht  aus dem Niederschlagswasser,  das den Boden er-

reicht – je nach Infiltrationsrate und Versickerungstiefe und unter Abzug der Verdunstungsmen-

ge – der Abfluss, der mit oder ohne Zwischenspeicherung ober- oder unterirdisch abfließt. Der

unmittelbar zum Abfluss gelangende Teil wird als abflusswirksamer bzw. effektiver Nieder-

schlag oder als direkter Abfluss bezeichnet. Unter Abflusskonzentration werden die horizonta-

len  Fließvorgänge  zusammengefasst,  die  das  abflusswirksame  Wasser  dem nächstgelegenen

Vorfluter zuführen. Dabei fließt der Oberflächenabfluss auf der Landoberfläche ab, der Zwi-

schenabfluss im Boden und der ungesättigten Zone des Grundwasserleiters, und der Grundwas-
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serabfluss in der gesättigten Zone des Grundwasserleiters. Das zeitliche Eintreffen der Teilab-

flüsse erfolgt in der Reihenfolge, in der sie eben genannt wurden. Im offenen Gerinne entwi-

ckelt sich aus den dort ankommenden Teilabflüssen schließlich ein Fließvorgang, bei dem das

Wasser im Gewässerbett ständig dem steilsten Gefälle folgend einem See oder dem Meer zu-

strömt (Baumgartner, Liebscher 1996).

Für die Entstehung pluvialer Hochwasser ist der Landoberflächenabfluss ausschlaggebend, zu-

dem der unmittelbare Direktabfluss aus dem Zwischenabfluss (zusammengenommen definiert

als „Direktabfluss“). Zwischen dem diskontinuierlich fallenden Niederschlag und dem kontinu-

ierlichen Abfluss stehen grundsätzlich die Verluste durch Interzeption und Muldenrückhalt. Der

Wert der Interzeption hängt vom Pflanzenbestand, der Jahreszeit, dem Wind, der Luftfeuchte

und der Verdunstung ab. Er stellt letztlich den Anteil des Niederschlags dar, der von den Pflan-

zen aufgefangen wird und – ohne den Boden zu erreichen – verdunstet. Als Muldenrückhalt

kann der Anteil des Niederschlags verstanden werden, der in natürlichen Unebenheiten bzw.

Senken der  Geländeoberfläche  zurückgehalten  wird  und von dort  entweder  verdunstet  oder

durch Versickerung stark verzögert zum Abfluss kommt (Maniak 2010). Beide Größen sind da-

her umso mehr zu berücksichtigen, je länger der Betrachtungszeitraum gewählt wird. Da für die

genaue Berechnung beider Größen umfangreiche Daten vorliegen müssen und andererseits plu-

viale Überflutungen durch vergleichsweise kurze und dafür umso stärkere Niederschlagsereig-

nisse ausgelöst werden, wird auf eine explizite Berücksichtigung von Interzeption und Mulden-

rückhalt bei der späteren Modellierung verzichtet. Wie bei Tyrna und Hochschild (2010) wird

der Direktabfluss mit Hilfe des Curve-Number-Verfahrens ermittelt, das auf Landnutzung und

Bodenart gründet und damit die beiden genannten Größen zumindest indirekt mit berücksich-

tigt. 

Zusammenfassend  gilt:  Je  weniger  Niederschlagswasser  im  Gelände  bzw.  im  Boden

(zwischen)gespeichert werden kann, desto größer ist das Volumen des Direktabflusses. Boden-

versiegelung erhöht damit grundsätzlich die Anfälligkeit eines Gebietes für pluviale Überflutun-

gen (Kaspersen et al. 2015). 

Pluviale Überflutungen können daher als Ereignis angesehen werden, von dem vor allem Sied-

lungsbereiche betroffen sind. Während stark erhöhter Oberflächenabfluss im freien Gelände mit

hoher Reliefenergie z.B. zu Murgängen an gefährdeten Hängen führen kann (Ritter et al. 2011),

dienen im urbanen „Gelände“ Wege und Straßen als Abflussbahnen. Die Überforderung des Ka-

nalnetzes stellt deshalb bei pluvialen Überflutungen einen wichtigen Faktor dar. Aufgrund der

Dimensionierung der Entwässerungssysteme auf Niederschlagsereignisse mit  relativ geringen

Wiederkehrintervallen ist bei Starkregenereignissen mit außergewöhnlich hohen Niederschlags-

mengen grundsätzlich mit (kurzfristigen) Überlastungen der städtischen Entwässerungssysteme

zu rechnen (Zahnt et al. 2017).

Weitere siedlungsspezifische Faktoren, die den Abfluss beeinflussen können, sind Böschungen

entlang von Infratsruktur (Straßen-, Schienennetz), Brücken oder Unterführungen, die künstli-

che Senken oder Abflussbarrieren darstellen können (Apreda 2016).
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2.2  Spezifika pluvialer Überschwemmungen und deren Abflussmo-
dellierung

Die Fließprozesse bei der Überschwemmung durch Gewässer werden vor allem durch das Quer-

profil des Flusses und durch ggf. vorhandene Querbauwerke beeinflusst. Wichtigste Eingangs-

größe bei der Modellierung von Flusshochwasser ist die Hochwasserganglinie des betrachteten

Gewässers, die aus einem Niederschlag-Abfluss-Modell generiert werden kann und den zeitli-

chen Verlauf der Hochwasserwelle im Gerinne an einem bestimmten Pegel angibt. Hinsichtlich

der Gefahrenflächen breiten sich fluviale Hochwasser ausgehend vom Gewässer flächig aus.

Die  Ausuferungen von Fließgewässern  sind  bei  lokalen  Starkregenereignissen  grundsätzlich

ebenfalls zu beachten, da sie beispielsweise zu einer Überlastung der Kanalisation führen kön-

nen. Bei Starkregen spielen jedoch andere Faktoren eine hervorgehobene Rolle, da die Fließpro-

zesse in der Fläche und nicht im Gerinne überwiegen. So sind vor allem die Rauheit der Ober-

fläche und das Relief für den Verlauf der flächigen Fließprozesse ausschlaggebend (Assmann et

al. 2012). In der Modellierung wird diesen Faktoren durch Verwendung des digitalen Gelände-

modells sowie durch Ermittlung und Verwendung des Rauigkeitsbeiwerts für Überlandabfluss

Rechnung getragen (s. Kap. 3.4.2.4 zur Berechnung des Rauigkeitsbeiwerts).

Hinsichtlich ihres hydrologischen Systemverhaltens unterscheiden sich die pluvialen Ereignisse

gegenüber Hochwasser in größeren Flüssen besonders durch die charakteristisch kurze Reakti-

onszeit, also der Zeit zwischen dem auslösenden Niederschlagsereignis und dem Hochwasser-

scheitel. Von einer pluvialen Sturzflut wird typischerweise bei einer Reaktionszeit von nicht

mehr als sechs Stunden gesprochen (Bronstert et al. 2017, De Boer 2016). Der deutsche Wetter-

dienst (DWD) bezieht sich auf diesen Zeitraum beispielsweise auch bei den Schwellenwerten

seiner Unwetterwarnungen1. Für Starkregen finden sich dort die folgenden Regenmengen:

Tabelle 1: Starkregendefinition nach Regenmenge

Starkregen 
Regenmenge in [l/m²] 

1 Stunde 6 Stunden

Markante Wetterwarnung 15-20 20-35

Unwetterwarnung > 25 > 35

Quelle: DWD-Wetterlexikon: Starkregen.

Ab einer Niederschlagsmenge von mehr als 35 l/m² (bzw. mm/m²), die in einem Zeitraum von

sechs Stunden über einem bestimmten Gebiet fällt,  kann demnach von einem Regenereignis

ausgegangen werden, dass pluviale Überschwemmungen zur Folge haben kann.

Eine besondere Rolle bei der Entstehung pluvialer Hochwasser spielt die Entstehung von Hang-

abfluss, welcher dem betrachteten Gebiet von höher gelegenen Geländepunkten zufließt oder im

Siedlungsgebiet selbst entsteht und dort über weitgehend versiegelte Flächen abfließt  (Tyrna

und Hochschild 2010). Statt einer Hochwasserganglinie dient dementsprechend flächiger Nie-

derschlag als Eingangsgröße. Für eine aussagekräftige Modellierung ist es daher essentiell, den

Niederschlagsinput möglichst genau abbilden zu können. Als Alternative zur Festlegung eines

statistischen Einheitswertes (z.B. 10- oder 50-jähriges Niederschlagsereignis), was oft bei Nie-

1 Vgl. Definition Starkregen im DWD-Wetterlexikon unter 
https://www.dwd.de/DE/service/lexikon/begriffe/S/Starkregen.html 
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derschlags-Abfluss-Modellen  für  Flusshochwassermodellierungen  Anwendung  findet,  bieten

Radardaten räumlich und zeitlich variable Werte, was gerade bei der Modellierung von Starkre-

genereignissen mit ihren lokal begrenzten und kleinräumig sehr unterschiedlichen Intensitäten

einen wichtigen Informationsgewinn darstellt (Berne und Krajewski 2013). Zur Ermittlung des

Effektivniederschlags (hier gleichzusetzen mit dem Direktabfluss) stellt das oben bereits ange-

sprochene Curve-Number-Verfahren (CNV) eine relativ einfach umzusetzende, empirische Me-

thodik dar. Beim CNV handelt es sich um ein weltweit verbreitetes Verfahren, das vom ehema -

ligen Soil Conservation Service (SCS, heute NRCS) des US Department of Agriculture entwi-

ckelt wurde. Die Curve Number (CN) stellt dabei eine Art Abflusskoeffizient dar, dessen Wert

sich zwischen 0 und 100 bewegt (je höher der Wert, desto höher der Direktabfluss) und aus der

im Untersuchungsraum vorhandenen Landnutzung und Bodenart resultiert  (Tyrna und Hoch-

schild 2010). 

Zwar haben Merz et al. (2006) für österreichische Verhältnisse und Einzugsgebietsgrößen von

80-10.000 km² Defizite des CNV identifiziert: So ist der meist angenommene Anfangsverlust

von 20 % der Speicherkapazität des Gebietes für österreichische Verhältnisse zu hoch. Ein Wert

von 5 % sei besser geeignet. Außerdem berücksichtigt das CNV die Vorbefeuchtung nur über

den Niederschlag in den letzten 5 Tagen vor dem Ereignis. Dies erscheine für österreichische

Verhältnisse nicht ausreichend repräsentativ für den Feuchtezustand eines Gebietes zu sein, der

Feuchtezustand der Gebiete werde durch Niederschlag und Verdunstung über einen wesentlich

längeren Zeitraum bestimmt.

Das hier entwickelte Modell wird zwar anhand eines Untersuchungsraums in Österreich vorge-

stellt, es soll aber auch auf andere Regionen und Länder anwendbar sein. In Hinblick auf diese

Generalisierbarkeit müssen daher gewisse Ungenauigkeiten oder Nicht-Berücksichtigung von

Spezifika, die für ein besonderes Gebiet gelten, in Kauf genommen werden. Der Anfangsverlust

wird tatsächlich auf 5 % reduziert, da dieser nicht nur für österreichische Verhältnisse, sondern

für die gesamten mitteleuropäischen Verhältnisse besser geeignet ist (Maniak 2010, Tyrna und

Hochschild 2010).  Bezüglich der Vorbefeuchtung kann angemerkt werden, dass ein pluviales

Ereignis, bei dem in kürzester Zeit große Niederschlagsmengen fallen, auch bei nicht wasserge-

sättigten  Böden  rasch  Oberflächenabfluss  auslösen  kann,  weil  die  Wassermenge  deutlich

schneller auf die Oberfläche trifft, als sie in den Boden infiltrieren kann. Daher ist das Problem

der Vorsättigung hier nicht so gewichtig wie bei der Modellierung von fluvialen Überschwem-

mungen.

Zur Berücksichtigung des städtischen Kanalsystems können 2-D-Abflussmodelle beispielsweise

mit 1-D-Modellen verknüpft werden, um die Interaktion bzw. Rückkopplung zwischen Oberflä-

chenabfluss und Entwässerungssystem abzubilden. In jedem Fall müssen dafür detaillierte In-

formationen über das urbane Entwässerungssystem vorliegen.  Ist dies nicht der Fall, oder soll

die Modellierung nicht zu komplex werden, besteht eine Möglichkeit in der Annahme, dass die

Entwässerungssysteme bei einem Starkregenereignis nach kurzer Zeit überlastet sind und bei

der Modellierung die Kapazitäten nicht berücksichtigt werden müssen  (Tyrna und Hochschild

2010). Eine Alternative, die es erlaubt, den Einfluss des Kanalsystems dennoch überschlägig zu

berücksichtigen, zeigen Kaspersen et al. (2015) auf: Der Einfluss des Kanalsystems wird model-

liert,  indem eine maximale  Aufnahmefähigkeit  des  Kanals  angenommen  wird;  anschließend

wird die Menge vom Regen-Input subtrahiert. Als Richtwert für die Dimensionierung des Ka-

nals wird ein 5-jähriges Regenereignis angenommen, d.h. hinsichtlich Niederschlägen, die sta-
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tistisch einmal in 5 Jahren oder häufiger auftreten, wird angenommen, dass der Kanal die Re-

genmenge  aufnehmen kann und es nicht  zu einer pluvialen Überflutung im urbanen Gebiet

kommt.  Schwächen zeigt der Ansatz allerdings bei Einzugsgebieten, die neben dem urbanen

Gebiet weiträumige ländliche Strukturen mit Landwirtschaftsflächen und/oder Wald aufweisen.

Eine allgemeine Reduzierung des Niederschlags würde implizieren,  dass in diesen Gebieten

ebenfalls eine Kanalisation wirksam ist.

Die Wahl des Modellierungsansatzes wird letztendlich davon abhängen, welche Informationen

für das Untersuchungsgebiet vorliegen und auf welcher Maßstabsebene die Modellierung durch-

geführt werden soll. Im vorliegenden Fall, mit dem Ziel eines generalisierten Modells, mit dem

eine möglichst gute Übertragbarkeit auf verschiedene Gebiete erreicht werden soll, wird in An-

lehnung an Tyrna und Hochschild (2010) auf eine Berücksichtigung des Kanalnetzes verzichtet.

2.3  Einfluss von Klimawandel und Siedlungsentwicklung

Berichte über Hochwasser bzw. Überflutungen infolge von Starkregenereignissen und die damit

verbundenen verursachten Schäden haben vor allem in den letzten Jahren verstärkt zugenom-

men. Betrachtet man die letzte Klimaperiode von 30 Jahren (1981-2010), dann lässt sich im glo-

balen Mittel ein Anstieg extremer („record-breaking“) Niederschlagsereignisse um 12 % fest-

stellen. Die Prognosen der Klimawandel-Szenarien gehen von einem weiteren Anstieg solcher

Ereignisse aus, sowohl hinsichtlich der Anzahl als auch hinsichtlich der Intensität (Lehmann et

al. 2015). 

Der wichtigste Einflussfaktor, der  das Gefährdungspotenzial in besiedelten Gebieten erhöht, ist

das Vorhandensein und die Zunahme von versiegelten Flächen, die eine Infiltration des Nieder-

schlagswassers in die Bodenschicht verhindern und so den Direktabfluss fördern. Bei ihrer Un-

tersuchung der Dänischen Stadt Odense kamen Kaspersen et al. (2015) zum Ergebnis, dass der

kombinierte Einfluss aus der Zunahme von versiegelten Oberflächen in urbanen Gebieten und

den Auswirkungen des Klimawandels mit einer Zunahme von Wetterextremen wie Starkrege-

nereignissen die Anfälligkeit gegenüber eines pluvialen Hochwasserereignisses um 112 % bis

152 % erhöht.

In hügeligen oder bergigen Regionen mit hoher Reliefenergie werden unter wachsendem Sied-

lungsdruck oftmals nicht nur weitgehend ebene Flächen in Tallage, die vormals landwirtschaft-

lich bewirtschaftet wurden, für die Ausweisung neuer Baugebiete genutzt, viele Siedlungserwei-

terungen finden auch in Hanglagen statt. In vielen Fällen werden dafür Waldflächen gerodet,

verbunden mit einer weiteren Reduktion des natürlich vorhandenen Rückhaltevermögens des

Bodens und einem verstärkten Anfall von (Hang-)Wasser in bestehende Entwässerungssysteme.

In Österreich sind diese Entwicklungen vor allem in den expandierenden Randlagen der größe-

ren Städte oder in Lagen mit guter Verkehrsanbindung zu beobachten (Zahnt et al. 2017). 

Für die Kommunen ergibt sich durch die Zunahme von Starkregenereignissen ein erheblicher

Mehraufwand in Zusammenhang mit Neubau, Wartung und Instandhaltung der Entwässerungs-

systeme. Neben dem reinen Flächenverbrauch bzw. der Neuversiegelung von Flächen, ist es da-

her auch das (vielfach noch) unangepasste Regenwassermanagement, das in städtischen Gebie-

ten das Risiko von Überflutungen nach Starkregenereignissen erhöht. Mangelnde Dimensionie-
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rung des Kanalnetzes sowie fehlende Strukturen zum Rückhalt und zur Wiederverwendung von

Niederschlagswasser sind hier exemplarisch zu nennen (Apreda 2016). 

Eine wirksame Begegnung der Gefahr durch pluviale Überflutungen wird daher vor allem in ei-

ner  weitsichtigen  und  klimawandel-angepassten  Siedlungsentwicklung  liegen.  Die  Kenntnis

über das Gefährdungspotenzial bestimmter Gebiete ist dabei von großer Relevanz. Im Naturge-

fahrenatlas Österreichs2 werden inzwischen beispielsweise in der Gefahrenhinweiskarte „Ober-

flächenabfluss“ „Mögliche Eintrittspunkte von Oberflächenabfluss in den Siedlungsraum“ dar-

gestellt. Laut der Datenbeschreibung können so in Verbindung mit Vor-Ort-Kenntnissen für be-

stehende Siedlungen bzw. Siedlungsentwicklungen mögliche Gefährdungen abgeschätzt und be-

rücksichtigt werden.

2 Natural Hazard Overview & Risk Assessment Austria – HORA, https://www.hora.gv.at, hrsg. v. Bundesministe-
rium für Nachhaltigkeit und Tourismus (BMNT)
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3.  Modellierung pluvialer Hochwasserereignisse

3.1  Untersuchungsraum Einzugsgebiet Mondsee mit Teileinzugsge-
biet Koppl

Als Untersuchungsraum der Modellierung dient das Einzugsgebiet (EZG) des Mondsees im ös-

terreichischen Salzkammergut, das je zu einem Teil in den Bundesländern Salzburg und Ober-

österreich liegt, und speziell dessen Teil-Einzugsgebiet Koppl.

Abbildung 2: Untersuchungsraum EZG Mondsee mit Teil-EZG Koppl
Datengrundlage der Hintergrundkarte: basemap.at (www.geoland.at // www.basemap.at)

Das ca. 248 km² große Einzugsgebiet Mondsee lässt sich orographisch in zwei Teile unterschei-

den. Die im Süden gelegenen nördlichen Kalkalpen bilden den alpinen Teil mit einer maxima-

len Erhebung von 1.782 Metern über dem Meeresspiegel.  Nördlich davon erstreckt sich der

flachwellig-hügelige Landschaftsteil  der  glazial  geprägten Beckenlandschaft  der  Flyschzone.

Das heutige Landschaftsbild resultiert aus der pleistozänen Vergletscherung und postglazialen

Ablagerungen. Der Mondsee bildet mit 478 m über dem Meer den tiefsten Punkt des Untersu-

chungsraums. Die Distanz vom höchsten zum tiefsten Punkt des Untersuchungsraums beträgt

gerade drei  Kilometer,  wodurch der  stark reliefierte  Charakter  des  Einzugsgebietes  deutlich

wird. Diese extreme Geländeausprägung ist auch verantwortlich für sehr starke Niederschlags-
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unterschiede. Die durchschnittliche jährliche Niederschlagsmenge liegt im Norden bei ca. 800

mm, im Süden dagegen bei ca. 1.800 mm (Burkhard et al. 2016).  

Die Wahl des Untersuchungsraums hat vorrangig die folgenden Gründe: Die Region weist die

Landschaftsstrukturen auf, die ein pluviales Hochwasserereignis gemäß der obigen Definition

begünstigen. Die vorwiegend durch fluvioglaziale Prozesse geformte Landschaft weist die dafür

typischen hügeligen Strukturen auf, die Siedlungsgebiete sind vorwiegend in den Talräumen ge-

legen und damit oft am Fuße der umgebenden Hügelflanken. Das Gebiet weist eine Vielzahl an

mittelgroßen und kleineren Seen auf und ist mit einem fein verzweigten Netz von Fließgewäs-

sern  durchzogen  (vgl.  Übersichtskarte  Untersuchungsraum  und  Geländedarstellung  in  Kap.

3.4.1). Aufgrund der unmittelbaren Nähe zu den Alpen im Süden weist die Region hohe durch-

schnittliche Niederschläge auf, nicht selten treten auch Starkniederschläge auf. So verzeichnet

die ZAMG-Unwetterchronik3 für die auswählbaren Jahre 2016-2019 beispielsweise am 25. Juni

2016, am 07. Mai 2017 und am 08. Juni 2018 Unwetter mit Starkregen im gewählten Untersu-

chungsraum. Für die spätere Modellbildung des Realzustands wird das Ereignis des 08. Juni

2018 gewählt. Das genaue Datum eines solchen Extremereignisses ist wichtig für die Auswahl

der passenden Radar-Niederschlagsdaten und die Möglichkeit zur Validierung des Modells.

Der überwiegend ländliche Charakter der Siedlungsbereiche mit großflächigen Landwirtschafts

und Weideflächen in der direkten Umgebung begünstigt einerseits oberflächlich auftretenden

Abfluss und eignet sich andererseits gut für die Entwicklung eines Modell-Szenarios mit zusätz-

licher Versiegelungen im Rahmen potenzieller Siedlungserweiterung.

Der interfakultäre Fachbereich Geoinformatik – Z_GIS der Universität Salzburg unterhält im

Koppler Einzugsgebiet das sog. Koppler Landschaftslabor (landscape lab)4. Dabei handelt es

sich um ein Netzwerk aus Sensoren zur Messung von meteorologischen, hydrologischen und

bodenkundlichen Umweltparametern.  Es dient  vorrangig der Untersuchung und des Monito-

rings der raum-zeitlichen Verteilung des Wassers im und auf dem Boden, mit dem Ziel, in Zu-

kunft Extremereignisse wie beispielsweise durch Starkregen verursachte Hangrutschungen oder

Überflutungen besser prognostizieren und entsprechende Vorbereitungen treffen zu können. Da

das Koppler Einzugsgebiet ein hydrologisches Teileinzugsgebiet des Mondsee-Einzugsgebietes

ist, liegt durch diverse Datenerhebungen im Rahmen des landscape lab für das Mondsee-Ein-

zugsgebiet eine sehr gute Datengrundlage vor. Die grundsätzliche Zielrichtung der Arbeit, ein

Modell zu entwickeln, das nicht auf nur lokal verfügbare Detailkartierungen angewiesen und

damit möglichst gut auf verschiedene Regionen anwendbar ist, wird dadurch nicht in Frage ge-

stellt. Die verfügbaren Daten sind aber gut zur Validierung der Modell-Basis-Daten geeignet.

Die Hochwassermodellierung selbst wird innerhalb des Koppler Einzugsgebiets durchgeführt.

Dies hat zum einen technische Gründe: Die Modellierung eines 248 km² großen Gebiets mit ei-

ner Rasterzellenauflösung von 1x1 Meter sprengt die Möglichkeiten der GUI-Version von Floo-

dArea. Die Obergrenze des erforderlichen Arbeitsspeichers liegt hier bei 2 GB. Der benötigte

Arbeitsspeicher für das gesamte Einzugsgebiet Mondsee liegt etwa um das zehnfache höher bei

20 GB. Der benötigte Arbeitsspeicher für das Einzugsgebiet Koppl mit einer Flächengröße von

ca. 6 km² liegt dagegen bei 299 MB.

3 https://www.zamg.ac.at/cms/de/klima/klima-aktuell/unwetterchronik: Kategorieauswahl >> Niederschlag >> 
Starkregen)

4 http://landscapelab.zgis.at
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Zum anderen entspricht die Größe des EZG Koppl auch weitaus besser dem zu modellierenden

Ereignisfall. Pluviale Hochwasserereignisse zeichnen sich ja besonders durch ihre Kleinräumig-

keit und kleinräumige Abgrenzung aus. In den meisten Fällen werden die Szenarien also für ein-

zelne Gemeinde- oder Stadtgebiete in dieser Größenordnung entwickelt und modelliert werden

und nicht für ein großflächiges Gesamteinzugsgebiet wie das EZG Mondsee.

In Abhängigkeit der Datenverfügbarkeit, -beschaffung, -verarbeitung und -validierung werden

die Datensätze in den folgende Kapiteln zum Teil für das gesamte EZG Mondsee dargestellt

und erläutert. Besonderheiten beim Zuschnitt der Daten auf das EZG Koppl werden an entspre-

chender Stelle erörtert.

3.2  Ausgewähltes Niederschlagsereignis

Die ZAMG-Unwetterchronik nennt für das Ereignis des 8. Juni 2018 die folgenden Detailinfor-

mationen:

Abbildung 3: ZAMG-Unwetterchronik: Detailinformationen zum Ereignis am 8. Juni 2018

Die folgende Abbildung zeigt die räumliche Verteilung der 24-Stunden-Summe dieses Nieder-

schlagsereignisses,  abgeleitet  aus  den  ZAMG-Radardaten  und  zugeschnitten  auf  das  EZG

Mondsee (zur Aufbereitung der Radardaten s. Kap. 3.4.4).
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Abbildung 4: 24-Stunden-Niederschlagssumme des Ereignisses vom 8. Juni 2018 im EZG 

Mondsee mit Teil-EZG Koppl

Mittels statistischer Analyse der Datensätze lassen sich die folgenden Niederschlagswerte ermit-

teln. 1h-, 3h- und 6h-Maximum stellen dabei jeweils das gleitende Maximum innerhalb des 24-

stündigen Ereignisses dar. 

Tabelle 2: Mittlere Niederschlagswerte im EZG Mondsee und Teil-EZG Koppl am 8. Juni 2018

 EZG 

Niederschlag in mm/m² 

24h-Summe absolut gemittelt über EZG

Min Max 1h-Maximum 3h-Maximum 6h-Maximum 24h-Summe

 Mondsee 0,08 51,26 5,49 5,72 5,78 5,79

 Koppl 34,17 51,26 43,60 43,83 43,84 43,84

Quelle: Eigene Berechnung aus ZAMG-Radardaten.

Aus den Werten lassen sich die folgenden Aussagen ableiten: Betrachtet man die Absolutwerte

der innerhalb von 24 Stunden gefallenen Regenmenge, so zeigt sich, dass es im EZG Mondsee

Gebiete gibt, in denen kaum Niederschlag gefallen ist (0,08 mm). Im Teil-EZG Koppl liegt das

Minimum dagegen bei 34,17 mm, das Maximum von 51,26 des EZG Mondsee liegt passend

dazu ebenfalls im Teil-EZG Koppl. 

Betrachtet man die über die EZG gemittelten Niederschlagswerte, so wird nochmals verdeut-

licht, dass es sich beim Niederschlagsereignis vom 8. Juni 2018 um ein lokal sehr begrenztes

Ereignis handelt. Die niedrigen Werte im EZG Mondsee von 5-6 mm weisen darauf hin, dass es
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in weiten Teilen des EZG Mondsee keine nennenswerten starken Regenfälle gegeben haben

kann. Im Teil-EZG Koppl dagegen liegen die mittleren Niederschlagswerte deutlich über 43

mm. Dabei zeigt sich zudem, dass die Haupt-Regenmenge innerhalb einer einzigen Stunde ge-

fallen ist.

Gemäß der oben genannten Grenzwerte für Unwetterwarnungen liegt der Wert von 43,6 mm/m²

selbst für ein 6-stündiges Niederschlagsmaximum deutlich oberhalb der Grenze für Unwetter-

warnungen. Fällt diese Menge innerhalb einer Stunde, muss von einem schweren Unwetter mit

der Gefahr von pluvialen Überschwemmungen ausgegangen werden.

3.3  Datengrundlage und Datenmodell

Die folgende Tabelle liefert eine Zusammenstellung mit den wichtigsten Basisinformationen der

für die Modellierung erforderlichen und verwendeten Datensätze. Eine detaillierte Beschreibung

der Daten sowie der Methoden zur Datenaufbereitung und -integration findet sich in den nach-

folgenden Kapiteln.

Tabelle 3: Verwendete Datengrundlage

Bezeichnung 
Geodaten

Datenquelle Bezug
Datenfor-

mat

Auflösung /
Koordina-

tenreferenz-
system

Einheit

Satellitenbilder 
Sentinel 2A

ESA-Copern-
icus-Programm

Kostenlose Be-
reitstellung über 
Copernicus Open 
Access Hub

Raster 10x10 m /
20x20 m je
nach Spek-

tralband

[EPSG32633]

-

Übersichtskarte 
Hydrologische 
Bodengruppen

FutureWater: HiHy-
droSoil database

Kostenlose Down-
load-Bereitstel-
lung auf Anfrage 
per E-Mail

Raster 1x1 km

[EPSG4326]

Nominale
Einteilung in
Gruppen A-D

Radar Nieder-
schlagsdaten

ZAMG: INCA-Sys-
tem

Bereitstellung im 
Rahmen von For-
schungsprojekten;
Bezug über Uni-
versität Salzburg

CSV 1x1 km

[EPSG4326]

1/100 mm pro
km²

Digitales Gelän-
demodell

LiDAR-Befliegung Digitale Bearbei-
tung und Bezug 
über Universität 
Salzburg

Raster 1x1 m

[EPSG32633]

vertikal
[WGS1984]

m

Gebäudeumrisse Digitale Katastral-
mappe (DKM) des 
Bundesamt für 
Eich- und Vermes-
sungswesen (BEV)

Bezug über Uni-
versität Salzburg

Vektor cm-Bereich -

Quelle: Eigene Zusammenstellung.

Das verwendete digitale Geländemodell (DGM) mit einer Rasterweite von 1x1 m wurde aus ei-

ner LiDAR-Befliegung generiert.  In Kombination mit  den Gebäudeumrissen der DKM wird

daraus das Eingaberaster der Geländeoberfläche generiert. 
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Aus den Sentinel 2A-Satellitenbildern des ESA-Copernicus-Programms mit  einer räumlichen

Auflösung im sichtbaren Spektrum von 10x10 m wird mittels Bildklassifizierung die Landnut-

zung im Untersuchungsraum identifiziert. Aus der Landnutzung wird einerseits der entsprechen-

de Rauigkeitsbeiwert  abgeleitet,  der  als  Parameter  im Modell  angegeben wird.  Andererseits

dient die Landnutzung auch als Grundlage für das (CNV) zur Ermittlung des effektiven Nieder-

schlags. Für das CNV werden neben der Landnutzung auch die hydrologischen Bodeneigen-

schaften bzw. die Zuordnung zur hydrologischen Bodengruppe benötigt, die der High-resolution

map of Soil Hydraulic properties von FutureWater entnommen wird, die als weltweiter Raster-

datensatz mit einer Zellengröße von ca. 1 km zur Verfügung steht.

Die Niederschlagshöhe wird schließlich aus Radardaten des INCA-Systems der ZAMG ermit-

telt. Dafür werden aus den im 1x1 km-Rasternetz und im 5-Minuten-Intervall vorliegenden Nie-

derschlagsmengen für einen ausgewählten Tag mehrere statistische Werte berechnet und einer

davon (hier 3h-Maximum) für die nachfolgende Modellierung ausgewählt. Anschließend wird

aus der Niederschlagshöhe mit Hilfe des CNV der effektive Niederschlag berechnet. 

Die Geländeoberfläche, die Rauigkeitsbeiwerte und das Beregnungsraster des effektiven Nie-

derschlags stellen schließlich die Eingaberaster für die Modellierung der Überschwemmungsbe-

reiche mit FloodArea dar. Das folgende Flussdiagramm fasst die eben beschriebenen Schritte

visuell zusammen und stellt  den schematischen Ablauf der Datenaufbereitung und -integration

für die Hochwassermodellierung dar.
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Abbildung 5: Schematischer Ablauf der Datenintegration zur Hochwassermodellierung

Die Abbildung dient einer generellen Übersicht der Ausgangsdaten, der berechneten Zwischen-

ergebnisse und der Output-Daten sowie der wichtigsten Verarbeitungsschritte. Es handelt sich

um eine vereinfachte Darstellung, bei der manche Zwischenschritte (z.B. zur Anpassung der

räumlichen Auflösung) weggelassen wurden, um die Übersichtlichkeit zu wahren. Alle Verar-

beitungs- und Integrationsmethoden werden in den nachfolgenden Kapiteln detailliert  darge-

stellt und beschrieben. 
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3.4  Datenaufbereitung und Datenintegration

Bei der Erstellung von Rasterdatensätzen muss grundsätzlich darauf geachtet werden, dass in

den Umgebungseinstellungen bei „Verarbeitungsausdehnung“ sowohl die Ausdehnung als auch

ein Fangraster angegeben werden. Als Referenz wird hier jeweils das DGM verwendet. So kann

sichergestellt werden, dass alle Ergebnis-Raster über den gleichen Ursprung, die gleiche Zellen-

ausrichtung und die gleiche Anzahl an Spalten und Zeilen verfügen. Die ist eine elementare

Voraussetzung für die anschließende Modellierung der Überschwemmungsbereiche mit Floo-

dArea.

3.4.1  Digitales Geländemodell

Eine der wichtigsten Grundlagen der Modellierung von Überschwemmungsflächen stellt das di-

gitale Geländemodell dar. Die DGM-Rasterdaten sind gerade für die 2D-Modellierung von hy-

drologischen  Ereignissen  von  eminenter  Bedeutung,  da  für  jede  Rasterzelle  Berechnungen

durchgeführt werden können, wobei eine Vielzahl an hydrologisch relevanten Parametern mit in

die Berechnung zur Hochwassermodellierung einbezogen werden kann (vgl. Kap. 3.6). Für eine

realitätsnahe Modellierung des Oberflächenabflusses ist die Datenqualität des verwendeten Di-

gitalen Geländemodells von entscheidender Bedeutung. 

Für viele Regionen liegt mittlerweile flächendeckend ein LiDAR-basiertes DGM mit 1 m Auf-

lösung im Rasterformat vor (LiDAR: Light Detection And Ranging). Die Geländehöhe inner-

halb der Rasterzelle wird aus den umliegenden Höhenpunkten interpoliert und wird daher ge-

nauer, je mehr Höhenpunkte zur Verfügung stehen. Der flugzeuggetragene Laserscanner liefert

eine Messpunktdichte von mehreren Punkten pro Quadratmeter und eine Höhengenauigkeit von

ca. 10 cm (Mandlburger et al. 2009). Je detaillierter die Hochwassermodellierung sein soll, des-

to genauer muss das DGM angepasst werden. Bei der hydraulischen Modellierung von Abfluss-

prozessen in Fließgewässern spielt beispielsweise die exakte Gerinnestruktur und das Vorhan-

densein abflusshindernder Querbauwerke wie Brücken und Wehre eine essentielle Rolle. Das

DGM kann und muss hier auf verschiedene Weise bearbeitet und angepasst werden (Mandlbur-

ger et al. 2009).

Im vorliegenden Fall der Identifizierung pluvialer Überschwemmungsgebiete ist vor allem der

Oberflächenabfluss über Land von Bedeutung. Da es sich zudem um eine möglichst übertragba-

re, generalisierte Modellierung handelt, die ohne lokal zu sehr spezifizierte Daten auskommen

soll, wird auf die Einbeziehung von Querbauwerken verzichtet. Informationen über abflusshin-

derne Bauwerke müssen erfahrungsgemäß für jeden lokalen Bereich von der örtlichen Wasser-

wirtschaftsverwaltung angefordert und vor Ort inspiziert werden und erfordern eine oft einzel-

fallbezogene Einarbeitung in das Modell.

Da bei der Modellierung pluvialer Überschwemmungsgebiete vor allem der Abfluss in besiedel-

ten Gebieten untersucht werden soll, ist es allerdings wichtig und sinnvoll, das DGM so aufzu-

bereiten,  dass  bei  der  Abflussmodellierung Gebäude umflossen  werden können (vgl.  hierzu

auch Tyrna und Hochschild 2010). Zu diesem Zweck werden die Gebäudeumrisse im Untersu-

chungsraum aus der DKM in ein Raster exportiert und mit einer einheitlichen Höhe von 5 Me-

tern auf das DGM aufsummiert.
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Der Verarbeitungsprozess muss in mehreren Schritten durchgeführt werden. Im ersten Schritt

werden die Gebäude-Umrisse auf die Ausdehnung des DGM zugeschnitten (Analysis Tools >

Extrahieren > Ausschneiden), anschließend wird den Attributdaten ein neues Feld hinzugefügt

(Data Management Tools > Felder > Feld hinzufügen: „Hoehe“). In diesem Feld wird allen

Gebäuden mittels der Funktion „Feld berechnen“ und einem Python-Code-Block (s. auch An-

hang B) eine einheitliche Gebäudehöhe von 5 Metern zugewiesen (Data Management Tools >

Felder  >  Feld  berechnen:  Parser:  Python,  Ausdruck:  FieldCal  (!Hoehe!),  def  FieldCal

(hoehe): return 5). Im zweiten Schritt werden die Vektor-Daten unter Verwendung des neu er-

stellten Feldes „Hoehe“ in ein Raster-Dataset konvertiert (Conversion Tools > In Raster > Fea-

ture in Raster: Feld: Hoehe, Zellengröße: 1; Umgebungseinstellungen: Verarbeitungsausdeh-

nung wie DGM, Fangraster DGM). Die Angabe der Verarbeitungsausdehnung ist dabei wich-

tig, damit das Ausgaberaster in den Bereichen ohne Gebäudeumrisse den Wert 'No Data' zuge-

wiesen bekommt. Dies wiederum ist Voraussetzung für die anschließende Raster-Berechnung.

Diese erfolgt im dritten Schritt mit dem Werkzeug „Raster berechnen“ und hier einem Conditio-

nal  (Con)-Ausdruck  (Spatial  Analyst  Tools  >  Map  Algebra  >  Raster  berechnen:

Con(IsNull("GebRaster_EZG"),"DGM_EZG",("GebRaster_EZG" + "DGM_EZG")). In den Be-

reichen, in denen das Gebäude-Raster keine Daten aufweist (IsNull), werden die ursprünglichen

Daten des DGM verwendet, ansonsten werden das DGM und das Gebäude-Raster addiert. Das

kombinierte DGM erhält die Bezeichnung „DGM_Geb_EZG“.

Die folgende Abbildung zeigt das Geländerelief im EZG Mondsee (zur besseren Visualisierung

mit Fließgewässernetz, das allerdings nicht für die Modellierung verwendet wird): 

Abbildung 6: Geländerelief und Fließgewässernetz im EZG Mondsee
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Und das Gelände im Teil-EZG Koppl mit den addierten Gebäudeumrissen:

Abbildung 7: Geländerelief mit Gebäudeumrissen (schwarz) im EZG Koppl

Die Tal- und Grabenstruktur des Nesselgrabens und des Plainfelder Bachs ist (Bereich Salz-

burgring in der oberen Hälfte des EZG) ist signifikant. Zudem lässt sich erkennen, dass das Ge-

lände im EZG mit größeren Erhebungen im Westen und Osten von einem relativ kleinräumigen

variablen Relief gekennzeichnet ist.  

3.4.2  Landnutzung

Der Untersuchungsraum EZG Mondsee ist  durch einen klaren ländlichen Charakter gekenn-

zeichnet. Siedlungsflächen inkl. Infrastrukturanlagen nehmen nur einen Anteil von ca. 6,5 %

ein.  Den größten Teil bilden Landwirtschaftsflächen mit  ca.  39 % und Waldflächen mit  ca.

44 % Flächenanteil (eigene Berechnung nach DKM-Daten). Was die landwirtschaftliche Nut-

zung anbelangt, werden durch die klimatischen Verhältnisse mit u.a. hohen jährlichen Nieder-

schlagsmengen vor allem Grünlandwirtschaft und Viehzucht begünstigt. Der überwiegende Teil

der Landwirtschaftsflächen wird als Dauergrünland in Form von Mähwiesen und Mähweiden

genutzt, Ackernutzung hat flächenmäßig eine nur geringe Bedeutung. Die Mähwiesen werden

größtenteils drei- bis viermal pro Jahr gemäht, auf den Mähweiden finden drei bis vier Nutzun-

gen pro Jahr statt (Bohner und Schink 2007). 

Die konkrete Landnutzung im EZG Mondsee bzw. im EZG Koppl wird aus frei verfügbaren Sa-

tellitenbilddaten der Satellitenmission Sentinel 2 abgeleitet. Die Sentinel-Missionen sind Teil

des europäischen Erdbeobachtungsprogramms Copernicus. Bei Sentinel 2 handelt es sich um

eine Mission mit multispektralen hochauflösenden Sensoren, die vor allem Daten für die Um-

weltbeobachtung hinsichtlich Landnutzung, Klima sowie Katastrophen- und Krisenmanagement
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liefern soll. Die Missionen Sentinel-2A und Sentinel-2B sind 2015 bzw. 2016 gestartet, durch

die Kombination der beiden Systeme ergibt sich eine Wiederkehrzeit von fünf bis sieben Tagen.

Im Abstand von fünf bis sieben Tagen wird demnach die jeweils gleiche Stelle der Erdoberflä-

che überflogen und entsprechende Sensordaten werden zur Verfügung gestellt. Die Sentinel 2-

Sensoren umfassen insgesamt 13 Spektralbänder und liefern Aufnahmen im optischen und na-

hen Infrarotbereich. Je nach Spektralband werden die Bilder in einer räumlichen Auflösung von

10, 20 oder 60 Metern aufgenommen. Eine Zusammenfassung der bisherigen und künftig ge-

planten Sentinel-Missionen mit detaillierten technischen Angaben und Informationen zum Orbit

findet sich zum Beispiel bei Iurist et al. (2016). 

Für die im Rahmen dieser Arbeit durchgeführte Bildanalyse zur Ableitung der Landnutzung

werden die drei optischen Bänder B2 (blau), B3 (grün) und B4 (rot) verwendet, die alle in einer

räumlichen Auflösung von 10 mal 10 Metern aufgenommen werden.

3.4.2.1   Suche und Download geeigneter Sentinel 2-Aufnahmen

Die Daten der Sentinel-Satelliten werden derzeit  über die „Data Hub Services“ (DHuS) des

„Copernicus Open Access Hub“ der ESA bereitgestellt.5 Voraussetzung für den Zugriff auf die

Sentinel-Daten ist – unabhängig vom Zugriff-Tool – die kostenlose DHuS-Registrierung.6

Für die Suche und den Download von Satellitenbildern steht auf den DHuS eine Web-Anwen-

dung und eine Programmier-/Anwendungsschnittstelle (API) zur Verfügung. Mit den „ArcGIS

Sentinel 2 Download Tools“ werden von ESRI Geoprozessierungs-Werkzeuge zur Verfügung

gestellt, die das Herunterladen von Daten via DHuS und die direkte Integration der Daten in die

ArcGIS-Umgebung unterstützen. Die Tools sind in Python programmiert und können als Tool-

box in ArcGIS integriert werden. Die Toolbox ist für ArcMap ab Version 10.5 einsetzbar,7 Arc-

GIS Pro wird derzeit noch nicht unterstützt. Die Werkzeuge können zur freien Nutzung im Esri-

GitHub-Repository8 als ZIP-Archiv heruntergeladen und anschließend in einem beliebigen Da-

teiverzeichnis entpackt und von dort aus gestartet werden (ESRI 2018). 

Für den Such- und Download-Vorgang werden zwei aufeinander folgende Werkzeuge benötigt.

Das in einen beliebigen Ordner entpackte ZIP-Archiv wird dafür über eine Ordnerverbindung in

ArcMap eingebunden; wichtig ist, dass alle zugehörigen Hilfsdateien aus dem ZIP-Archiv vor-

liegen und dabei ihre relativen Pfade erhalten bleiben. Die folgende Abbildung zeigt die über

den Ordner „SentinelDlTool“ in ArcMap integrierte Toolbox:

5 https://scihub.copernicus.eu

6 https://scihub.copernicus.eu/dhus/#/self-registration 

7 Die Verwendung von ArcMap in der Version 10.4.1 ist ebenfalls möglich, sofern vorab noch zusätzlich erforder-
liche Patches installiert werden.

8 https://github.com/EsriDE/ArcGIS-Sentinel2-Download-Tools 
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Abbildung 8: ArcGIS-Sentinel-Download-Toolbox

Zunächst wird das Werkzeug „Search DHuS catalog“ ausgeführt, die folgende Abbildung zeigt

das Eingabefenster mit den für den Untersuchungsraum eingegebenen Parametern:

Abbildung 9: Eingabe-Dialog Search DHuS catalog
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Als Processing Level wird „2A“ gewählt, das Level-2A-Produkt wird von der ESA mittels des

sen2cor-Prozessors aus dem jeweiligen Level-1C-Produkt abgeleitet, d.h. aus dem Top-Of-At-

mosphere (TOA)-Datensatz wird durch die atmosphärische Korrektur ein Bottom-of-Atmosphe-

re (BOA)-Datensatz erstellt. Dem 2A-Produkt sind zudem einige zusätzliche Rasterdatensätze

beigefügt,  u.a.  eine Szene-Klassifikation,  sowie Klassifizierungsverlässlichkeiten für Wolken

und Schnee/Eis (ESRI 2018). Die Szene-Klassifikation verfügt aber über zu wenig Klassen, als

dass sie direkt für die Klassifzierung der Landnutzung verwendet werden könnte.

Als  Zeitraum  sollte  eigentlich  ein  Zeitfenster  rund  um das  zu  untersuchende  Ereignis  am

8.06.2018 gewählt werden. Aus technischen Gründen konnten aber in der Zeit, in der diese The-

sis erstellt wurde, keine Sentinel-Daten aus dem Jahr 2018 heruntergeladen werden. Die Anfra-

ge mittels Search DHuS catalog lieferte jedes mal eine Fehlermeldung (internal server error).

Ersatzweise wurde daher für diese Arbeit der vergleichbare Zeitraum des Vorjahres als Such-

zeitraum verwendet. Als Zeitraum wird daher ein Zeitfenster vom 1.05.2018 bis 31.08.2018 ge-

wählt. 

Der gewählte Zeitraum stellt einen Kompromiss dar, der unter Umständen durch „Ausprobie-

ren“ angepasst werden muss. Die folgenden Kriterien sollen erfüllt werden:

• die Aufnahme soll möglichst nah am zu modellierenden Ereignis liegen;

• die Wolkenbedeckung soll maximal 15% betragen (s. Angabe im Auswahlfenster); mit

hoher  Wahrscheinlichkeit  liegt  das  Modellgebiet  dann  in  einem wolkenfreien  Aus-

schnitt, was allerdings im Nachgang und vor dem Download manuell überprüft werden

muss;

• es sollen nicht viel mehr Satellitenbilder als notwendig ausgewählt werden, um den an-

schließend durchzuführenden Auswahlvorgang zu beschleunigen (Begrenzung auf 25

Resultate, s. Angabe im Auswahlfenster).

Für die Festlegung des Suchraums können Koordinaten oder alternativ ein Layer aus der Arc-

Map-Umgebung verwendet werden, in diesem Fall die Umgrenzung des EZG Mondsee. Ausge-

wählt werden dadurch Kacheln, die den Suchraum mindestens schneiden. Ob eine Aufnahme

den Suchraum also vollständig abdeckt, muss anschließend überprüft werden, ggf. kann auch

ein Mosaik-Dataset aus verschiedenen Kacheln zusammengesetzt werden.

Durch Ausführen des Werkzeugs werden Informationen über die zur Verfügung stehenden Sa-

tellitenaufnahmen heruntergeladen und in einem Raster-Katalog namens „product“ gespeichert,

der über ArcCatalog in die ArcGIS-Umgebung eingebunden werden kann.  Die vorhandenen

Kacheln werden als Umgrenzungs-Polygone (optional mit Vorschaubild) angezeigt:
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Abbildung 10: EZG Mondsee (blau) mit überlappenden Sentinel 2-Bildkacheln

Anhand der zugehörigen Attributtabelle kann der Benutzer nun die Kacheln auswählen, für die

er tatsächlich die Sentinel 2-Satellitendaten herunterladen möchte.

Abbildung 11: Kachel-Auswahl für Download

Nach Auswahl der in Frage kommenden Kacheln, z.B. durch optische Überprüfung der Überde-

ckung des Suchraums und/oder anhand des Grades der Wolkenbedeckung (Attributfeld „Cloud-

Cover“ und Vorschaubilder), werden Kacheln zum Download ausgewählt, indem im Attribut-
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feld „Marked“ anstelle des Standardwerts 'Null'  ein numerischer Wert größer '0'  eingegeben

wird. Der Wert bestimmt die Reihenfolge des Downloads, und zwar vom größten zum kleins-

ten. Nach dem Abspeichern der Änderungen wird das zweite Werkzeug der Toolbox „Down-

load Marked packages“ ausgeführt:

Abbildung 12: Eingabe Download Marked packages

Neben der  Angabe des  Product-Katalog,  in  dem sich die  vorher  getroffenen Angaben zum

Download der Kacheln befinden (Änderungen im Feld „Marked“ der Attributtabelle) und einem

Download-Verzeichnis  muss  zwischen  drei  Arbeitsmodi  ausgewählt  werden  (ESRI  2018):

„Cart-only“ erzeugt eine XML-Datei, die den Inhalt des Warenkorbs beschreibt. Diese Option

kann verwendet werden, wenn nur das Suchergebnis für andere Anwendungen weiterverwendet

werden soll. Der Modus „Image-selection“ bietet die Möglichkeit, einzelne Bilddateien einer

Kachel auszuwählen wie z.B. einzelne Spektralbänder. Beim hier  verwendeten Modus „Full

product“ werden die Satellitendaten in vollem Umfang im SAFE (Standard Archive Format for

Europe)-Produktformat heruntergeladen. Der Download kann dabei nicht direkt in eine Geoda-

tabase erfolgen, bei der Wahl des Verzeichnisses muss auf kurze Ordnerpfade geachtet werden

(ESRI 2018).

Wenn wie in dieser Arbeit mit  den optischen Spektralbändern in 10 m-Auflösung gearbeitet

werden soll, kann über ArcCatalog die Verarbeitungsvorlage Multispectral-10m direkt in die

aktuelle ArcMap-Arbeitsumgebung eingefügt werden („BOA Reflectance-10m“):
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Abbildung 13: Hinzufügen von Multispektral 10 m über ArcCatalog

Nach endgültiger  Auswahl  der  Bildkachel  wird diese in der  FGDB „Sentinel.gdb“ als Ras-

ter-Dataset „T33UUP_20170829_BOA10m“ gespeichert. Die in der BOA-10 m-Datei vorhan-

denen vier Spektralbänder B2, B3, B4 und B8 werden beim Import in die FGDB umbenannt in

Band_1, Band_2, Band_3 und Band_4. Für die Echtfarbendarstellung als RGB-Komposit in Ar-

cMap ergibt sich dadurch: Rot: Band_3, Grün: Band_2, Blau: Band_1. Für alle weiteren Verar-

beitungsschritte wird dieses Dataset verwendet. 

3.4.2.2   Klassifizierung der Landnutzung aus Sentinel 2A

Zur Klassifizierung der Landnutzung aus den Sentinel 2A-Daten wird das in ArcMap integrierte

Werkzeug „Bildklassifizierung“ verwendet. Nach der Systematik der überwachten pixelbasier-

ten  Bildanalyse  werden  zunächst  einzelne  Trainingsgebiete  festgelegt,  die  anschließend  als

Grundlage für die Klassifizierung der gesamten Szene verwendet werden.

Die Daten der Landnutzung werden später benötigt, um daraus die Rauigkeit der Oberfläche für

den Oberflächenabfluss abzuleiten, und um zusammen mit den hydrologischen Bodengruppen

jeder Landnutzungskategorie einen CN-Wert zuweisen zu können. Da das Modell den Anspruch

hat, möglichst allgemein anwendbar zu sein, wurde die Anzahl der Landnutzungsklassen nach

dem Motto „so viele wie nötig, aber so wenig wie möglich“ festgelegt. Die folgenden sechs

Landnutzungsklassen wurden gewählt:

• Versiegelte Oberfläche (z.B. bebaute Wohnflächen, Straßenflächen)

• Rohboden (z.B. Rohstoffabbauflächen, offene Steinböden)

• Acker (Anbau von Feldfrüchten)

• Grünland (Dauergrünland, Wiese, Weide)

• Wald (Nadelwald, Laubwald, Mischwald)

• Wasser 

Nach dieser Vorgabe werden die folgenden Trainingsgebiete ausgewählt und digitalisiert:
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Abbildung 14: ArcMap-Bildklassifizierung: Trainingsgebiete

Mit diesen Trainingsgebieten wird anschließend im Bildklassifizierungsmenü „Klassifizierung“

die „Interaktive, überwachte Klassifizierung“ durchgeführt. Das Ergebnis stellt sich wie folgt

dar:
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Abbildung 15: ArcMap-Bildklassifizierung: Landnutzung nach sechs verschiedenen Klassen

Die Abbildung zeigt die Klassifizierung in die o.g. sechs Landnutzungsklassen. Ein Blick  in die

linke Bildmitte (nördlich des großen klassifizierten Waldbereichs) zeigt, dass Wolken wie ver-

siegelte Flächen dargestellt werden. Da bei der Kachelauswahl bereits darauf geachtet worden

ist, dass sich im Untersuchungsraum kaum Wolkenbedeckung befindet, und sich im zu model-

lierenden Bereich des EZG Koppl keine Wolkenbedeckung befindet, können Klassifizierungs-

fehler durch Wolkenbedeckung ausgeschlossen werden. 

Eine Auffälligkeit bei der ersten optischen Kontrolle stellen die Uferlinien der stehenden Ge-

wässer dar, die großteils der Klasse „versiegelte Oberfläche“ zugeordnet werden. Flachwasser-

bereiche und Wasserschwankungsbereiche mit steiniger (z.B. kiesiger), heller Oberfläche könn-

ten für diese systematische fälschliche Zuordnung verantwortlich sein.

Für die Validierung und spätere Weiterverarbeitung ist es sinnvoll und notwendig, den einzel-

nen Landnutzungsklassen aufeinanderfolgende Werte von '1' bis '6' zuzuweisen. Die Zuweisung

der Werte kann der Tabelle im nächsten Kapitel entnommen werden.

3.4.2.3   Validierung mittels DKM-Daten

Zur Validierung der aus den Sentinel 2A-Daten (S2A) extrahierten Landnutzung werden die

Landnutzungsdaten der Österreichischen Digitalen Katastralmappe (DKM) herangezogen. Die

DKM-Landnutzungsdaten liegen für das EZG Mondsee als Polygon-shapes in insgesamt 28 Ka-

tegorien vor. Um die Datensätze vergleichbar zu machen, werden die 28 Kategorien der DKM
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zu den sechs aus S2A klassifizierten Kategorien zusammengefasst. Die nachfolgende Tabelle

gibt einen Überblick, welche Kategorien wie zusammengefasst werden.

Tabelle 4: Landnutzung aus DKM und aus S2A 

 Landnutzungsklassen DKM Landnutzungsklassen S2A Zugewiesener Wert

Baufläche befestigt Versiegelt 1

Gebäude

Straßenanlage

Techn. Ver-/Entsorgung

Techn. Ver-/Entsorgungsanlage

Werksgelände

Abbaufläche Rohboden 2

Fels/Geröll

Alpen Acker (Sonstiges) 3

Brachland

Deponie

Erholungsfläche

Lagerplatz

Sonstige

Sonstige Fläche

Sumpf

Ödland

Baufläche begrünt Grünland 4

Bergmahd

Gärten

Garten

Hutweide

Landwirtschaftlich genutzt

Streuobstwiese

Weide

Wiese

Wald Wald 5

Gewässer fließend Wasser 6

Gewässer stehend

In den DKM-Daten sind einige Klassen enthalten, die aufgrund ihrer Bezeichnung nicht eindeu-

tig einer der sechs Ziel-Klassen zugeordnet werden können. So kann die DKM-Klasse „Brach-

land“ beispielsweise „Wald“ oder „Landwirtschaftsfläche“ sein, die DKM-Klasse „Erholungs-

fläche“ kann theoretisch alle Oberflächenausprägungen der Ziel-Klassen enthalten. Die betrof-

fenen DKM-Klassen werden zur ebenfalls in den DKM-Daten vorhandenen Klasse „Sonstiges“

zusammengefasst und bekommen den Wert '3' zugeordnet. Dieser Wert entspricht in den S2A-

Landnutzungsdaten der Klasse 'Acker'. Diese Gegenüberstellung wurde aus zwei Gründen ge-

wählt: erstens ist die Klasse 'Acker' in den DKM-Daten nicht vorhanden, da hier sowohl Grün-
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land- als auch Ackerflächen ohne weitere Unterscheidung in der Kategorie 'Landwirtschaftlich

genutzt' enthalten sind; zweitens umfasst die Klasse 'Acker' in den S2A-Daten nur einen sehr

kleinen Flächenanteil, was die Auswirkungen auf das Ergebnis minimiert.

Diese Vorgehensweise ermöglicht  eine einfachere Gegenüberstellung der beiden Datensätze,

ohne weitere Auswahldatensätze erstellen zu müssen, weil jeweils die gleichen Werte '1'-'6' vor-

handen sind. Andererseits entsteht so ein „vorprogrammierter“ Fehler,  da die Pixel mit  dem

Wert '3' in den Datensätzen definitiv nicht übereinstimmen können. In den DKM-Daten nimmt

die Klasse „Sonstiges“ ('3') einen Anteil von 1,5 % ein, in den S2A-Daten nimmt die Klasse

'Acker' ('3') einen Anteil von 0,6% ein. Der vorprogrammierte Fehler liegt demnach bei maxi-

mal 1,5 %.

Zur  geometrischen  Zusammenfassung  werden  die  ArcMap-Werkzeuge  „Zusammenführen“

(Data Management Tools > Generalisierung > Zusammenführen (Dissolve): Feld: „BEZ“ //

Editor > manuelles Zusammenführen nach 5 vorhandenen Kategorien) verwendet. Anschlie-

ßend wird dem Datensatz das zusätzliche Feld „VALUE“ hinzugefügt und den DKM-Landnut-

zungsklassen werden dieselben numerischen Werte zugeordnet wie den S2A-Landnutzungsda-

ten. Danach wird die DKM-Feature-Class basierend auf dem „VALUE“-Feld in ein Raster (10

mal 10 Meter, analog zu S2A) umgewandelt. Um für den nächsten Schritt eine exakte Überde-

ckung der beiden Datensätze sicherzustellen, wird der S2A-Datensatz beim Rastern als Fangras-

ter benutzt (Conversion Tools > In Raster > Feature In Raster; Umgebungseinstellungen: Ver-

arbeitungsausdehnung wie S2A_LN, Fangraster S2A_LN).  

Die Überprüfung der Übereinstimmung der S2A-Landnutzungsdaten mit den DKM-Landnut-

zungsdaten erfolgt mit Hilfe des Werkzeugs „Häufigkeit gleicher Werte“ (Spatial Analyst Tools

> Lokal). Als Ergebnis wird ein Raster berechnet, das die zwei Werte '0' und '1' aufweist (0 =

keine Übereinstimmung, 1 = Übereinstimmung):
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Abbildung 16: Übereinstimmung Landnutzung DKM-Daten mit S2A-Daten

Betrachtet man die Anzahl der Pixel, dann ergeben sich 452.965 Pixel, die keine Übereinstim-

mung aufweisen, und 2.010.952 Pixel, die eine Übereinstimmung aufweisen. Daraus ergibt sich

eine Fehlerquote von 18% bzw. eine Übereinstimmungsquote von 82%. Unter Berücksichtigung

des o.g. „vorprogrammierten“ Fehlers kann das Klassifizierungsergebnis mit gut 80 % Genauig-

keit als sehr akzeptabel betrachtet werden.

3.4.2.4   Berechnung des Rauigkeitsbeiwerts

Die Art der Landnutzung im Untersuchungsraum stellt für die Hochwassermodellierung eine

wichtige Eingangsgröße dar, weil von ihr u.a. die Rauheit der Oberfläche abgeleitet werden

kann, auf der Oberflächenabfluss entsteht. Die Rauheit der Grundfläche mit Berücksichtigung

der darauf befindlichen Objekte beeinflusst wesentlich die hydrodynamische Reibung und die

Fließgeschwindigkeiten  und  bildet  damit  einen  wichtigen  Faktor  bei  der  Abflusssimulation

(Dorn et al. 2014).

In der  Modellbildung wird die  Oberflächenrauigkeit  durch ein Eingaberaster  berücksichtigt,

über das jeder Landnutzungsklasse ein Rauigkeitsbeiwert zugeordnet wird. In FloodArea muss

die Oberflächenrauigkeit nach Strickler als kSt (=1/n) in der Einheit [m1/3/s ] angegeben werden.

Für nicht spezifizierte Rauigkeitsbeiwerte verwendet FloodArea den Standardwert '25' (Geomer

2017).

Für die sechs ermittelten Landnutzungsklassen finden sich in der Literatur verschiedene Rauig-

keitsbeiwerte, die sich zum Teil deutlich voneinander unterscheiden. Die folgende Tabelle gibt

einen Überblick der Beiwerte, wie sie bei Maniak (2010), Dorn et al. (2014) und dem Bayeri-
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schen LfU (2017) verwendet werden. Letztgenannte Quelle stellt den Anhang eines Handlungs-

leitfadens zur Hochwassermodellierung dar, der sich in der Planungspraxis im Ingenieurbüro als

sehr praxistauglich erwiesen hat.

Tabelle 5: Rauigkeitsbeiwerte nach Strickler

Landnutzungsklasse
Rauigkeitsbeiwert nach Strickler kSt (=1/n) [m1/3/s]

Maniak Dorn et al. LfU

 Versiegelt 50 63 40

 Rohboden 10 k.A. 30

 Acker 5 29 15

 Grünland 3 29 20

 Wald 2 7 10

 Wasser k.A. 20 30

 Ø 14 29,6 24,2

Quelle: Maniak (2010), S. 316/319; Dorn et al. (2014), S. 1748; LfU (2017), S. 11-12.

Für die spätere Modellierung werden die Rauigkeitsbeiwerte des LfU-Leitfadens verwendet, da

hier zum einen für alle benötigten Landnutzungsklassen Werte vorliegen und diese sich zum an-

deren bei diversen Hochwassermodellierungs-Projekten als sehr gut geeignet erwiesen haben.

Zusätzlich ergibt sich bei den LfU-Werten ein Durchschnittswert von '24', was ziemlich genau

dem von FloodArea verwendeten Standardwert von '25'  entspricht.  Die Werteskala des LfU

scheint also relativ gut zum FloodArea-Modell zu passen. Die Verteilung der Rauigkeitsbeiwer-

te im EZG Koppl ist in der folgenden Abbildung dargestellt:

Abbildung 17: Rauigkeitsbeiwerte im EZG Koppl

Was die  Modellierung von Gebäuden in Hochwassermodellen  angeht,  gibt  es  grundsätzlich

zwei Möglichkeiten: entweder die Gebäudehöhe (bzw. eine Standardhöhe) wird auf das DGM
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addiert und die Gebäude werden sozusagen aus dem Gelände herausgehoben, oder die Gebäude

bleiben „flach“, dafür wird aber die Oberflächenrauigkeit an der Stelle der Gebäude erhöht.

Nachteil der eigentlich realitätsnäheren Einbeziehung der Gebäude in das DGM ist, dass kein

Abfluss in Keller oder Tiefgaragen unterhalb von Gebäuden modelliert werden kann (Dorn et

al. 2014). In der vorliegenden Modellierung wird dieser Nachteil in Kauf genommen, und die

Gebäude werden, wie oben beschrieben, in das DGM integriert bzw. aufsummiert. Bei pluvialen

Hochwasserereignissen spielt gerade die Entstehung von Sturzbächen auf Wegen und Straßen

zwischen Häusern eine große Rolle, und dies kann am besten mit erhöhten Gebäudeblöcken si-

muliert werden. Der genannte Nachteil ist dann besonders gewichtig, wenn unterirdisch großflä-

chige Volumina wie z.B. große Tiefgaragen bestehen. Sind solche Einrichtungen im Modellge-

biet vorhanden, kann das Modell u.U. entsprechend verändert und angepasst werden, um den

hier befindlichen künstlichen Retentionsraum zu berücksichtigen.

3.4.3  Bodenart/Hydrologische Bodengruppe 

Die Bodentypen im Einzugsgebiet des Mondsees sind aufgrund der oben beschriebenen Land-

schaftsentstehung sehr vielfältig. Am häufigsten und am weitesten verbreitet sind Braunerden,

Kalkbraunlehme, Rendzinen und Ranker, Aueböden, Pseudogleye und Gleye sowie Anmoore

und Niedermoore. In den Tälern und Auen sowie abflusslosen Vertiefungen sind immer wieder

kleinflächige Moore und Vernässungen zu finden (Bohner 2007).

Für die Hochwassermodellierung werden die Angaben zu den Bodenarten im Untersuchungs-

raum benötigt, um den Effektivniederschlag zu ermitteln, also den direkt abfließenden Anteil

des  Gebietsniederschlags.  Wesentlich  sind  daher  die  Versickerungseigenschaften  der  Böden

bzw. ihr Wasserspeichervermögen.

Die Curve Number (CN) ist ein Maß für das maximale Speichervermögen S in Abhängigkeit

von der Bodenart,  der Landnutzung und dem Vorregen, der im Gebiet gefallen ist.  Die CN

reicht von 0 bis 100 und liegt tabelliert vor (s. Tabelle 6). Das Verhältnis von CN und S kann

folgendermaßen ausgedrückt werden:

CN=
25400
S+254

(1)

Wird S sehr groß, strebt CN gegen 0, auch bei hohen Niederschlägen tritt dann kein Oberflä-

chenabfluss ein. Für S = 0 wird CN = 100, d.h. der gesamte Niederschlag fließt oberflächlich ab.

Die umgekehrt proportionale Beziehung zwischen S und CN bewirkt, dass für Werte CN < 45

und Niederschläge < 100 mm praktisch kein Abfluss entstehen kann (Maniak 2010; s. Fomeln

in Kap. 3.4.4.2). Der Einfluss von Vorregen und Jahreszeit wird in drei Bodenfeuchteklassen

berücksichtigt. Als Vorregen wird die ungewichtete Niederschlagssumme der fünf dem Ereignis

vorangegangenen Tage verwendet. Meist wird von der Bodenfeuchteklasse II ausgegangen. Sie

entspricht einer 5-tägigen Niederschlagssumme zwischen 30 und 50 mm während der Vegetati-

onszeit und 15 bis 30 mm außerhalb der Wachstumszeit, d.h. einer mehr als durchschnittlichen,

wenn auch nicht extrem hohen Bodenfeuchte (Maniak 2010).

Um das Wasserspeichervermögen der  verschiedenen Bodenarten zum Ausdruck zu bringen,

werden im CNV vier hydrologische Bodengruppen gebildet (Maniak 2010):
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• Gruppe A: Böden mit großem Versickerungsvermögen (ca. > 8 mm/h), auch nach star-

ker Vorbefeuchtung, z.B. tiefgründige Sand- und Kiesböden;

• Gruppe B: Böden mit mittlerem Versickerungsvermögen (ca. > 4 mm/h), tief- bis mäßig

tiefgründige Böden mit mäßig feiner bis mäßig grober Textur, z.B. Sandböden, Löß,

(schwach)lehmiger Sand

• Gruppe C: Böden mit geringem Versickerungsvermögen (ca. > 1 mm/h), Böden mit fei-

ner bis mäßig feiner Textur oder mit wasserstauender Schicht, z.B. flachgründige Fein-

sande und sandiger Lehm;

• Gruppe D: Böden mit sehr geringem Versickerungsvermögen (ca. < 1 mm/h), Tonbö-

den, sehr flache Böden über nahezu undurchlässigem Material, Böden mit dauernd sehr

hohem Grundwasserspiegel.

Die Ableitung der hydrologischen Eigenschaften von Böden anhand des Bodentyps bzw. der

Bodenart stellt ein komplexes Verfahren dar, für das die Eigenschaften der einzelnen Bodenho-

rizonte als  sehr detaillierte Datengrundlage verfügbar sein müssen.  Da flächendeckende Bo-

denkartierungen sehr aufwendig sind, stellt die für das EZG Mondsee in großem Maßstab vor-

handene Bodenkartierung eher die Ausnahme als die Regel dar. Für viele Regionen stehen Bo-

denkartierungen in geeignetem Maßstab und ausreichender Detailschärfe nicht zur Verfügung.

Da es der Anspruch des hier entwickelten Datenmodells ist, möglichst gut auf verschiedene Ge-

biete übertragbar zu sein, werden die für das Modell benötigten hydrologischen Eigenschaften

der Böden nicht aus der Bodenkartierung abgeleitet. Stattdessen wird die „HiHydroSoil“-map

verwendet. Dabei handelt es sich um einen frei verfügbaren Rasterdatensatz, der die hydrologi-

schen Eigenschaften der Böden weltweit in einem Raster mit einer Zellengröße von ca. 1 km

zur Verfügung stellt (De Boer 2016).

Die ursprüngliche Ausgangsbasis für die HiHydroSoil-map stellt die „Global Soil Map of Hy-

draulic Properties“ dar, die 2011 aus der „Harmonized World Soil Databese“ erstellt  wurde.

Seitdem wurden immer  wieder neue und zusätzliche Bodendaten verfügbar gemacht,  zudem

wurden Rechenalgorithmen stetig verbessert, so dass 2014 eine weltweite Bodenkarte mit hoher

Auflösung  (1  km Zellengröße)  und  verbesserter  Qualität  erstellt  werden  konnte,  die  „Soil-

Grids1km“. Allerdings enthält diese Bodenkarte noch nicht die hydrologischen Kennwerte, die

für eine hydrologische Modellierung benötigt werden. Sie stellt aber die Basis dar, von der aus

mit spezifischen Rechenmethoden die hydraulischen Eigenschaften der einzelnen Bodentypen

abgeleitet  werden,  um als  Resultat  die  „High-resolution  map  of  Soil  Hydraulic  properties“

(HiHydroSoil-map) zu erhalten. Mit stetig sich verbessernder räumlicher Auflösung des Soil-

Grid1km (aktuell geplant bis zu einer Zellengröße von 100 m) wird künftig auch die HiHydro-

Soil-map in entsprechend verbesserter Auflösung zur Verfügung stehen (De Boer 2016).

Als Eingangsgrößen für die Ermittlung der hydrologischen Bodeneigenschaften dienen die fol-

genden Kennwerte der SoilGrids1km:

• Lagerungsdichte [kg/m³]

• Kationen-Austausch-Kapazität [cmol+/kg]

• Ton-Gehalt [%]
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• Organischer Kohlenstoff [g/kg]

• pH-Wert

• Schluff-Anteil [%]

• Sand-Anteil [%]

• Abstand zum Grundgestein [cm; 0-240]

Dabei steht jede Variable für sechs standardisierte Tiefenhorizonte zur Verfügung: 0-5 cm, 5-15

cm, 15-30 cm, 30-60 cm, 60-100 cm, 100-200 cm.

Für jeden dieser Horizonte werden insgesamt 14 Kennwerte der hydrologischen Bodeneigen-

schaften berechnet, u.a. der Anteil an organischen Bestandteilen, gesättigter Wassergehalt, ge-

sättigte hydraulische Leitfähigkeit, Feldkapazität, permanenter Welkepunkt etc. Alle Ziel-Varia-

blen im Detail sowie die verwendeten Rechen-Algorithmen können De Boer (2016) entnommen

werden. 

Für das hier entwickelte Datenmodell ist eine zusätzliche Zielgröße entscheidend, die nicht für

jeden einzelnen Bodenhorizont, sondern für den Bodenaufbau im Ganzen abgeleitet wird, die

hydrologische Bodengruppe (Hydrologic Soil Group – HSG). Hierfür wird zusätzlich eine inter-

polierte Karte der Grundwassertiefe verwendet. Die Zuordnung erfolgt schließlich zu den vier

oben genannten Bodengruppen A-D des CNV.

Außerdem ist die Zuordnung zu einer von drei dualen HSG möglich: A/D, B/D und C/D. Dies

hat den folgenden Hintergrund: Liegt der mittlere Grundwasserspiegel innerhalb der oberen 60

cm unterhalb der Oberfläche, wird der betreffende Boden der Gruppe D zugeordnet, auch wenn

die gesättigte hydraulische Leitfähigkeit an sich günstige Bedingungen hinsichtlich des Versi-

ckerungsvermögens aufweist. Können solche Böden ausreichend entwässert werden, werden sie

den dualen Bodengruppen A/D, B/D oder C/D zugerechnet, je nach ihrer gesättigten hydrauli-

schen Leitfähigkeit und der Höhe des mittleren Grundwasserspiegels im entwässerten Zustand.

Der erste Buchstabe bezieht sich auf den entwässerten Zustand, der zweite auf den unentwässer -

ten Zustand. Hinsichtlich der HSG bedeutet „ausreichend entwässert“, dass ein jahreszeitlich

betrachteter hoher Grundwasserstand mindestens 60 cm unterhalb der Oberfläche gehalten wer-

den kann (De Boer 2016).

Die HiHydroSoil-map liegt nach dem Download im geographischen Koordinatensystem (GCS)

WGS 84 (EPSG 4326) vor. Zur Integration ins Datenmodell wird sie zunächst in das projizierte

Kordinatensystem des Modells WGS 84 UTM Zone 33N (EPSG 32633) projiziert  (Data Ma-

nagement Tools > Projektionen und Transformationen > Projizieren). Anschließend wird sie

mit der Methode des kleinsten umgebenden Rechtecks auf das EZG Mondsee ausgeschnitten

(Data Management Tools > Raster > Raster-Verarbeitung > Ausschneiden: „Eingabe-Features

als Geometrie zum Ausschneiden verwenden“ deaktiviert), dann auf eine Rasterzellengröße von

10 m resampled (Data Management Tools > Raster > Raster-Verarbeitung > Resampling: Me-

thode: NEAREST) und schließlich auf die exakte Feature-Ausdehnung des EZG Mondsee zuge-

schnitten  (…  >  Ausschneiden:  „Eingabe-Features  als  Geometrie  zum  Ausschneiden

verwenden“ aktiviert). Der Arbeitsablauf mit zwei nacheinander geschalteten Ausschneidevor-

gängen  wird  aus  folgenden  Gründen  in  der  beschriebenen  Reihenfolge  durchgeführt:  Ein

Resampling der Gesamtdaten würde unnötig Rechenressourcen beanspruchen, andererseits kann
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der Datensatz auch nicht direkt auf die Feature-Ausdehnung des EZG Mondsee zugeschnitten

werden, da bei der vorliegenden großen Rasterweite von 1 km ansonsten Lücken im Randbe-

reich des EZG entstehen können. Das Feld „Ausschneideausdehnung beibehalten“ muss bei den

Ausschneidevorgängen deaktiviert bleiben, um die Beibehaltung der Zellenausrichtung und Zel-

lengröße sicherzustellen.

Die HiHyroSoil-map für das EZG Mondsee stellt sich schließlich wie folgt dar:

Abbildung 18: Hydrologische Bodengruppen im EZG Mondsee

Die Bodengruppen A-D werden in der Attributtabelle des Datensatzes durch die Zahlen 1-4 re-

präsentiert (duale Bodengruppen als entsprechende Kombination 14, 24, 34). Im EZG Mondsee

liegen demnach die Bodengruppen C und D vor, im EZG Koppl flächendeckend die Boden-

gruppe D.

3.4.4  Niederschlag

3.4.4.1   Aufbereitung der Radar-Daten

Die genaue Erfassung des Regengeschehens ist von zentraler Bedeutung für hydrologische Fra-

gestellungen  bzw.  Modellierungen,  die  auf  eine  Niederschlags-Abfluss-Beziehung  abzielen.

Wie oben bereits beschrieben, stellen Radardaten – trotz der bekannten Einschränkungen – eine

sehr gute Datenquelle für raumbezogene Analysen des Regengeschehens dar, da sie eine weit-

räumige und flächendeckende Wiedergabe der Niederschlagsverteilung ermöglichen. Die Ver-

ortung kleinräumiger Niederschlagszellen, die sich bei heftigem Starkregen oft sehr lokal bil-
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den, ist häufig nur durch die Analyse von Radarniederschlagsdaten möglich (Treis et al. 2017).

Zudem bieten Radardaten neben der hohen räumlichen auch eine hohe zeitliche Auflösung des

Intensitätsverlaufes (Bronstert et al. 2017). Schließlich gilt auch bei den Niederschlagsinforma-

tionen wieder der Grundsatz dieser Arbeit, dass eine räumlich möglichst breit verfügbare Daten-

grundlage gewählt werden soll, um das Modell für viele Regionen einsetzbar zu machen. Dies

ist bei Radardaten (verfügbar z.B. über die ZAMG oder den DWD) in einem weit höheren Maße

gegeben als bei Niederschlagsdaten aus punktuellen Wetterstationen, die meistens nicht in ei-

nem ausreichend dichten Messnetz vorhanden sind.

Die  hier  verwendeten  Radardaten der  ZAMG liefern Niederschlagswerte  in  einer  zeitlichen

Auflösung von 5 Minuten und in einem räumlichen Raster mit einer Zellengröße von 1 km. Die

Daten liegen in der folgenden Struktur vor: Für jeden Kalendertag existiert ein Datenordner, der

einzelne CSV-Dateien enthält, von denen jede einen Zeitraum von 5 Minuten abdeckt. Die Da-

teinamen enthalten das Datum und die Uhrzeit, zu denen die Daten aufgezeichnet wurden, bei -

spielsweise  sind  in  der  Datei  „inca_sbgl_20180608-1345+000“  die  Radarniederschlagswerte

vom 8. Juni 2018 um 13:45 Uhr enthalten. 

In den von der Uni Salzburg bereitgestellten Archivordnern sind die CSV-Dateien teilweise

doppelt enthalten, einmal mit dem Namenszusatz „sbgl“, einmal ohne:

Abbildung 19: Namensstruktur der Inca-CSV-Dateien

Bei den Daten ohne Namenszusatz „sbgl“ handelt es sich nach Informationen der Uni um Arte-

fakte aus früheren Analysen, so dass nur die Daten mit „sbgl“ die korrekten Daten sind, die für

die Analyse herangezogen werden. Die Datensätze ohne „sbgl“ werden nach dem Entpacken

des Archivordners manuell aus dem jeweiligen Tag-Verzeichnis entfernt.

Die CSV-Dateien selbst enthalten drei Spalten: Die Spalten 1 und 2 enthalten die Koordinaten-

angabe des Gitterpunktes im geographischen Koordinatensystem WGS 84 (EPSG 4326), Spalte

3 enthält den Niederschlagswert in 1/100 mm pro km².

Um die Niederschlagswerte in die ArcMap-Arbeitsumgebung integrieren zu können, sind ver-

schiedene  Bearbeitungsschritte  notwendig,  die  mit  Hilfe  eines  eigens  entwickelten  Py-

thon-Skripts  durchgeführt  werden.  Dieses  wird  als  Python-Skript-Werkzeug  in  die  Arc-

Map-Toolbox integriert. Gleichzeitig erfolgt in diesem Skript eine statistische Aufbereitung der

Daten. In vergleichbaren Analysen zu pluvialen Überschwemmungen wird zum Teil das 3-Stun-

den-Maximum der Niederschlagsmenge herangezogen (Treis et al. 2017), zum Teil das 6-Stun-

den-Maximum (Bronstert et al. 2017). Wie oben erläutert, wird zur hier vorgenommenen Mo-

dellierung das 3-Stunden-Maximum verwendet. Das entwickelte Python-Skript-Werkzeug zur

Aufbereitung der Radardaten erlaubt aber je auch die Verwendung des 1-Stunden- oder 6-Stun-

den-Maximums sowie der Tagessumme des Niederschlags im EZG.
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Das Python-Skript bzw. das Python-Skript-Werkzeug (s. Anhang B) umfasst die folgenden Ar-

beitsschritte:

• Erstellen einer leeren Point-Feature-Class in einer File-Geodatabase;

• Durchführung eines Tests,  ob alle CSV-Dateien im gewählten Verzeichnis derselben

räumlichen Ausdehnung entsprechen;

• Erstellen eines Punkt-Geometrie-Objekts aus den CSV-Koordinatenpaaren und Integra-

tion in die Point-Feature-Class;

• Einlesen  der  5-Minuten-CSV-Dateien,  Aufsummierung  der  Niederschlagswerte  zu

Stundenwerten nach Uhrzeit (01:00 Uhr bis 24:00 Uhr) und Integration in die entspre-

chenden Attributspalten der Point-Feature-Class;

• Berechnung  der  folgenden  statistischen  Niederschlagswerte:  1-Stunden-Maximum

(höchste Niederschlagssumme innerhalb einer Stunde); 3-Stunden-Maximum (höchste

Niederschlagssumme innerhalb eines gleitenden 3-Stunden-Bereichs, d.h. 01:00 Uhr bis

03:00 Uhr / 02:00 Uhr bis 04:00 Uhr / … / 22:00 Uhr bis 24:00 Uhr); 6-Stunden-Maxi-

mum  (höchste  Niederschlagssumme  innerhalb  eines  gleitenden  6-Stunden-Bereichs,

d.h. 01:00 Uhr bis 06:00 Uhr / 02:00 Uhr bis 07:00 Uhr / … / 19:00 Uhr bis 24:00 Uhr);

24-Stunden-Summe  (gesamte  Niederschlagssumme  innerhalb  der  ausgewählten  24

Stunden) und Integration in die entsprechenden Attributspalten der Point-Feature-Class.

Die Ausgabe-Point-Feature-Class enthält  schließlich 22.620 Punkt-Objekte,  die in einer Ma-

schenweite von 1 km vorliegen und jeweils die genannten berechneten Niederschlagswerte ent-

halten. Die Einheit der Niederschlagswerte entspricht 1/100 mm pro km².

Die anschließenden Arbeitsschritte zur weiteren Datenaufbereitung werden in ArcMap mittels

vorhandener integrierter Werkzeuge und ModelBuilder-Modelle durchgeführt (s. Kap. 3.5).

Da die Point-Feature-Class im GCS WGS 84 (EPSG 4326) vorliegt, wird sie zunächst in das im

Modell verwendete projizierte Koordinatensystem WGS 84 UTM Zone 33N (EPSG 32633) pro-

jiziert  (Prozess analog zu HSG, s. Kap. 3.4.3). Anschließend wird zwischen den Punkten ein

Dreiecksnetz mittels Delaunay-Triangulation erstellt (3D Analyst Tools > Datenmanagement >

TIN > TIN erstellen: Höhenfeld = Wertefeld, Tag-Feld = Wertefeld; die Einheiten für ein TIN

dürfen nicht  als geographische Koordinaten vorliegen,  daher ist  die Projizierung unbedingt

vorher durchzuführen). Aus diesem TIN wird schließlich mittels linearer Interpolation ein Ras-

ter erstellt  (3D Analyst Tools > Konvertierung > Von TIN > TIN in Raster: Ausgabedatentyp

FLOAT,  Methode:  LINEAR).  Dieses  wird  nach  der  bereits  beschriebenen Methode (s.  Kap.

3.4.3) auf den Untersuchungsraum bzw. das EZG zugeschnitten und auf eine Zellengröße von 1

m resampled. Das Ergebnis für das EZG Koppl stellt sich folgendermaßen dar:
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Abbildung 20: 3-stündiges Niederschlagsmaximum im EZG Koppl am 8. Juni 2018

3.4.4.2   Berechnung des Effektiv-Niederschlags

Für die Berechnung des Effektivniederschlags wird das Curve-Number-Verfahren (CNV) ver-

wendet. Die Formeln sind übernommen von Tyrna und Hochschild (2010). Der Effektivnieder-

schlag als direkt abfließender Anteil des Gebietsniederschlags wird berechnet nach:

Q=
(P−I )2

(P−I+S )

(2)

mit:

Q: Effektivniederschlag in mm

P: Gebietsniederschlag  in mm

I: Anfangsverlust in mm (als prozentualer Anteil von S)

S: potenzielle maximale Rückhaltemenge in mm

Der Anfangsverlust umfasst in erster Linie Benetzungs- und Muldenverluste zu Beginn des Nie-

derschlagereignisses. Diesbezüglich haben umfangreiche Untersuchungen gezeigt,  dass der An-

fangsverlust nach dem ursprünglichem CNV (I = 0,2 * S) für mitteleuropäische Verhältnisse oft

zu hoch angesetzt wird. Dies führt in der Folge dazu, dass der tatsächliche Abflussbeiwert in der

Regel um 8 bis 14 CN-Werte unterschätzt wird. Mit einem kleineren Anfangsverlust (z.B. von I

= 0,05 * S) können bessere Ergebnisse erzielt werden (Maniak 2010). Auch Tyrna und Hoch-

schild (2010) verwenden in ihrer Analyse den Wert 0,05 anstelle von 0,2. Dementsprechend gilt

auch in der vorliegenden Arbeit:

I=0,05∗S (3)
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Für die potenzielle maximale Rückhaltemenge S gilt folgende Beziehung zum CN-Wert:

S=
25400
CN

−254
(4)

 Setzt man die Gleichungen (3) und (4) in (2) ein, so erhält man für die Berechnung von Q:

Q=
(P−

1270
CN

+12,7)
2

P+
24130
CN

−241,3

(5)

In der  ArcMap-Arbeitsumgebung wird die  Berechnung mit  Hilfe  des  Raster-Calculators für

Map-Algebra-Operationen (Spatial Analyst Tools > Map Algebra > Raster berechnen) durchge-

führt. 

Der Wert für den Gebietsniederschlag P wird dem aufbereiteten INCA-Niederschlagsraster ent-

nommen. Für die Ermittlung des CN-Werts sind vorher noch zusätzliche Arbeitsschritte erfor-

derlich, da er anhand der Kombination von Landnutzung und hydrologischer Bodengruppe er-

mittelt wird. Dafür werden die beiden vorher erstellten Raster mit dem Werkzeug „Kombinie-

ren“ überlagert  (Spatial  Analyst  Tools  > Lokal  > Kombinieren).  Das Werkzeug kombiniert

mehrere Raster, sodass jeder eindeutigen Kombination von Eingabewerten ein eindeutiger Aus-

gabewert zugewiesen wird. Anschließend wird dem kombinierten Raster ein neues Feld „CN“

hinzugefügt, in das mit Hilfe des Werkzeugs „Feld berechnen“ (Data Management Tools > Fel-

der) die entsprechenden CN-Werte eingetragen werden (das eigentliche Wertefeld „VALUE“

ist standardmäßig für Feldberechnungen gesperrt). Die Zuweisung des CN-Werts zu jeder ein-

deutigen Kombination aus Landnutzung und HSG erfolgt über if-else-Ausdrücke. Dafür werden

alle möglichen Kombinationen in einem Python-Code-Block zur Verfügung gestellt (s. Anhang

B). 

Abbildung 21: Zuordnung des CN-Werts zum kombinierten Raster aus LN und HSG mit dem 

Werkzeug Feld berechnen

Die Kombinationen erfolgen aus den einzelnen Kategorien der Landnutzung (numerisch vorlie-

gend als 1-6) und den Kategorien der HSG (in der Attributtabelle vorliegend als 1-4, 14, 24,
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34), die CN-Werte liegen tabellarisch vor und werden entsprechend zugeordnet. Die gewählten

CN-Werte sind orientiert an der Aufstellung bei Tyrna und Hochschild (2010). Da die einzelnen

Landnutzungsklassen zum Teil sehr kleinteilig unterschieden werden, erfolgt die Zuordnung zu

den benötigten sechs Landnutzungsklassen wo nötig durch Mittelwertbildung. Dass bei den ver-

siegelten Flächen nicht der Wert '100' sondern '98' verwendet wird, kann dahingehend interpre-

tiert werden, dass dadurch die Aufnahme von Niederschlagswasser in ein Entwässerungssystem

abgebildet wird:

Tabelle 6: CN-Wert in Abhängigkeit von Landnutzung und HSG

 Landnutzungsklasse
Hydrologische Bodengruppe

A B C D A/D B/D C/D

versiegelt 98 98 98 98 98 98 98

Rohboden 77 86 91 94 86 90 93

Acker 64 76 84 88 76 82 86

Grünland 46 66 77 82 64 74 80

Wald 36 60 73 79 58 70 76

Wasser * 94 94 94 94 94 94 94

Quelle: verändert bzw. angepasst nach Tyrna und Hochschild (2010).

* Wertzuweisung als „wassergesättigter Rohboden“, da offene Wasserkörper in geringem Maße die Bo-
denfunktion „Wasserspeicher“ erfüllen.

Zur Weiterverarbeitung bzw. -berechnung wird mit  dem Reklassifizierungs-Werkzeug „Loo-

kup“ (Spatial Analyst Tools > Reklassifizieren > Lookup) aus den so berechneten Werten in der

Attributspalte „CN“ ein neues Raster erstellt, das dann die CN-Werte im Feld „VALUE“ ent-

hält. Die Verteilung der CN-Werte im EZG Koppl stellt sich folgendermaßen dar:

Abbildung 22: CN-Werte im Einzugsgebiet Koppl
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3.5  Modellbildung

Die Modellbildung setzt  sich aus mehreren Teilen zusammen,  die hintereinander  ausgeführt

werden.  Das  Python-Skript  zur  Aufbereitung  der  Inca-Regenradar-Daten  wird  als  Py-

thon-Skript-Werkzeug integriert, für die übrigen Prozesse kommen in ArcMap integrierte Werk-

zeuge zur Anwendung, für die Automatisierung wird der in ArcMap integrierte ModelBuilder

verwendet. Das Gesamt-Modell kann damit als teilautomatisierter Prozess bezeichnet werden.

• Im ersten Schritt wird aus den Inca-CSV-Dateien mittels Python-Skript-Werkzeug „In-

caCsvToPoint“ eine Punkt-Feature-Class erstellt;

• Im zweiten Schritt werden mittels ModelBuilder-Modell „IncaPointToRaster“ aus der

Inca-Punkt-Feature-Class Raster-Datasets zu ausgewählten statistischen Werten berech-

net (1h-Maximum, 3h-Maximum, 6h-Maximum, 24h-Summe);

• Im dritten Schritt werden mittels ModelBuilder-Modell „DataProcAllVar“ aus den er-

forderlichen Ausgangsdaten (DGM, Gebäudeumrisse, Umgrenzung EZG, Niederschlag,

Landnutzung, HSG) und den entsprechend erforderlichen Zwischenschritten die Raster-

Datasets berechnet, die als Eingabe für die Berechnung der Überschwemmungsgebiete

in FloodArea benötigt werden. 

Die  teilautomatisierte  Modellbildung mit  in  sich  abgeschlossenen hintereinandergeschalteten

Prozessen wurde bewusst gewählt. Es gibt inzwischen auch die Möglichkeit, FloodArea direkt

als Toolbox in die ArcMap-Arbeitumgebung einzubinden  (Geomer 2017), auf diese Variante

wird aber bewusst verzichtet. Aus diesem Vorgehen ergeben sich die folgenden Vorteile: Inner-

halb der Datenaufbereitung können erst einmal verschiedene Niederschlagsszenarien ausgewer-

tet werden (z.B. hinsichtlich des gewählten Zeitraums oder der statistischen Auswertung über

1h-/3h-/6h-Maximum, 24h-Summe), ohne immer direkt die komplette restliche Datenmodellie-

rung oder die Berechnung der Überschwemmungsgebiete anschließen zu müssen.  Vor allem

letztere stellt einen zeitaufwendigeren Prozess dar. Zum anderen können die aufbereiteten Da-

tensätze  so  auch  einfacher  für  eine  andere  Hochwasser-Simualtions-Anwendung  verwendet

werden. Die Eingangsdaten für solche Anwendungen sind sich meist ähnlich, ggf. müssen die

Datensätze in zusätzlichen Arbeitsschritten auf die speziellen Anforderungen der spezifischen

Software angepasst werden.

Als Varianten des dritten Modellschrittes „DataProvAllVar“ können die beiden ModelBuilder-

Modelle „DataProcLNVar“ und DataProcIncaVar“ verstanden werden. Dabei müssen nicht alle

Eingangs-Variablen  des  Haupt-Modells  ausgewählt  werden;  DGM,  Gebäude,  Umgrenzung

EZG und HSG werden dem Modell fest gemäß der Berechnung in „DataProcAllVar“ zugewie-

sen, und nur Landnutzung („DataProcLNVar“) bzw. Niederschlag („DataProcIncaVar“) können

als Parameter neu ausgewählt und damit verändert werden. Dies erleichtert es dem Benutzer, für

diese Variablen verschiedene Szenarien berechnen zu lassen;  zum Beispiel  für verschiedene

Niederschlagsereignisse  oder  bestimmte  Landnutzungsszenarien  im ansonsten  unveränderten

Untersuchungsraum. 

Die  im Folgenden beschriebene  Modellbildung zielt  konkret  auf  die  Berechnung der  Über-

schwemmungsgebiete mit FloodArea. Hinsichtlich des Datenformats der Eingangsdaten gelten

für die Modellierung mit FloodArea die folgenden Voraussetzungen (Geomer 2017):
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• Das Dateiformat der Eingabe-Raster muss GeoTIFF sein. Außerdem wird eine einheitli-

che räumliche Auflösung (d.h. gleiche Zellgröße) aller Raster-Layer vorausgesetzt;

• Alle Eingabe-Raster-Layer  müssen im gleichen Koordinatensystem vorliegen.  Damit

sollte gleichzeitig gewährleistet sein, dass keine unterschiedlichen Karteneinheiten vor-

handen sind. Die Berechnung mit Daten, die in einem geographischen Koordinatensys-

tem vorliegen, ist nicht möglich;

• Die  Einheit  der  Höhenwerte  wird  anhand  des  Geländemodells  im Hauptdialog  von

FloodArea für alle Eingangsdaten spezifiziert.

3.5.1  Speicher- und Datenstruktur

Nachfolgend ist die Speicherstruktur des Datenmodells in ArcCatalog dargestellt. Die Speicher-

orte befinden sich alle im Hauptverzeichnis „UNIGIS_MSc_Mod“.  Als workspace (auch für

temporäre Daten in Modelbuilder) wird durchwegs die FGDB „PluvMod“ angegeben. Für das

Kartendokument „UNIGIS_MSc_PluvMod“, das ebenfalls in diesem Hauptverzeichnis gespei-

chert ist, wird die Speicherung von relativen Pfadnamen aktiviert (Datei > Eigenschaften des

Kartendokuments), um die Weitergabe des Datenmodells zu vereinfachen. Das gleiche gilt für

die Modellwerkzeuge.

Abbildung 23: Ordnerstruktur des Datenmodells in ArcCatalog

Die folgende Tabelle liefert eine Zusammenstellung aller für die Modellbildung benötigten Da-

ten und Tools sowie aller im Zuge der Modellierung erstellten Daten mit genau nachvollziehba-

ren Datensatz-Bezeichnungen und Speicherorten. Zudem werden die im Rahmen der Arbeit ge-

nutzten oder erstellten Daten genannt, die nicht für die tatsächliche Modellierung und Berech-

nung relevant sind, aber zum Beispiel zu Visualisierungszwecken bestimmter Sachverhalte oder

im Rahmen der Darstellung der Methodik verwendet werden.
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Tabelle 7: Speicher- und Datenstruktur im Hauptverzeichnis UNIGIS_MSc_Mod

Speichername Speichertyp Daten Beschreibung

IncaArchive Dateiordner • archive_20141105-20141231

• archive_20150101-20151231

• archive_20160101-20161231

• archive_20170101-20171231

• archive_20180101-20180925

Gepackte Archivordner mit Inca-Radar-
Niederschlagsdaten; verfügbare Zeit-
räume:

• 5.11.2014 bis 31.12.2014

• 1.1.2015 bis 31.12.2015

• 1.1.2016 bis 31.12.216

• 1.1.2017 bis 31.12.2017

• 1.1.2018 bis 25.9.2018

IncaUnzippedDay_sbgl Dateiordner • archive_sbgl_20180608 * Ordner mit entpackten Inca-Ra-
dar-Niederschlagsdaten im CSV-For-
mat (5-Minuten-Intervall) für den in der
Modellierung gewählten Tageszeit-
raum: 8.6.2018

IncaTIN Dateiordner • CreateTin Ordner mit TIN, das als Zwischen-
schritt für die Berechnung von Raster-
Datasets aus der Inca-Punkt-Feature-
Class benötigt wird (Speicherung nur 
temporär, Ordner daher leer); TINs 
können nicht in FileGeodatabases ver-
waltet werden.

SentinelDlTool Dateiordner • doc

• lib

• lyr

• .gitattributes

• .gitignore

• ArcGIS Sentinel2 Download 
Tools-Anleitung

• LICENSE

• NOTICE

• README

• Sentinel.Download.pyt

• Sentinel.pyt

• Sentinel.Search.pyt

• Sentinel.tbx

Verzeichnis mit ESRI ArcGIS Senti-
nel2 Download Tool (für ArcMap ab 
10.4.1); 

für die Modellierung muss die „Senti-
nel“-Toolbox in die ArcMap-Arbeitsum-
gebung eingebunden werden; die übri-
ge Verzeichnisstruktur darf nicht ver-
ändert werden.

SentinelRawDl Dateiordner • S2A_MSIL2A_20170829T10
0031_N0205_R122_T32T-
QT_20170829T100026.SAF
E

• S2A_MSIL2A_20170829T10
0031_N0205_R122_T33TUN
_20170829T100026.SAFE

• S2A_MSIL2A_20170829T10
0031_N0205_R122_T33U-
UP_20170829T100026.SAF
E

Heruntergeladene und entpackte Sen-
tinel 2A-Daten im SAFE-Produktfor-
mat der ESA; 

enthalten sind drei Szenen gleichen 
Datums mit unterschiedlicher räumli-
cher Ausdehnung; für die Modellie-
rung wird der Datensatz _T33UUP_ 
verwendet.

HiHydroSoil Dateiordner • HiHydroSoil_TopSoil_Sub-
soil_gapfilled_Zipped

• HiHydroSoil – A high resolu-
tion soil map of hydraulic pro-
perties_v1.2

• Hydrologic_Soil_Group.tiff

• Hydrologic_Soil_Group.tif.vat
.

Verzeichnis der HiHydroSoil database,
bereitgestellt von FutureWater;

Im Unter-Verzeichnis 
„HiHydroSoil_TopSoil_Subsoil_gapfil-
led_Zipped“ sind die einzelnen Boden-
parameter für die beiden Bodenhori-
zonte 0-30 cm und 30-100 cm enthal-
ten; im PDF-Dokument *_v1.2 finden 
sich die detaillierten Erläuterungen zur
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• Hydrologic_Soil_Group.tif.vat
.cpg

• Hydrologic_Soil_Group_le-
gend

• Hydrologic_Soil_Group_QGI
S_legend

Datenbank, zur Datenbeschaffung und
zur Berechnung der hydrologischen 
Bodengruppen;

für die Modellierung wird der Raster-
datensatz Hydrological_Soil_Group im
tiff-Format verwendet.

ScriptFiles Dateiordner • PyScr_INCA_CsvToPoint

• Codeblock_FeldBer_CN

• Codeblock_FeldBer_Geb-
Hoehe

• Tab_Reclass_LN_Rauigkeit

Das Python-Skript „PyScr_INCA_Csv-
ToPoint“ ist die Skriptdatei für das in 
der Modellierung verwendete Python-
Skript-Werkzeug zur Datenaufberei-
tung und Umwandlung der Inca-CSV-
Daten in eine Punkt-Feature-Class mit
Berechnung der entsprechenden sta-
tistischen Werte;

Die beiden „Codeblock“-Dateien im 
txt-Format enthalten die Code-Blöcke, 
die in den Werkzeugen zur Berech-
nung des CN-Wertes und zur Integra-
tion der Gebäudehöhe in das DGM 
benötigt werden;

Die „Tab“-Datei im txt-Format enthält 
die Informationen zur Reklassifizie-
rung der Landnutzungsdaten mit Wer-
ten der Geländerauigkeit.

FloodArea_Input Dateiordner • Ganglinien

• modelReal

    → FA_DGM.tif

    → FA_IncaEff.tif

    → FA_Rauigkeit.tif

• modelSzenV

Datensätze im GeoTiff-Format und txt-
Format, die für die Berechnung der 
Überschwemmungsgebiete mit      
FloodArea benötigt werden;

Die Dateien sind in drei Unterordnern 
sortiert:

• Ganlinien: enthält die Ganglinie des 
Niederschlagsereignisses im txt-For-
mat (zur zeitlichen Steuerung der Nie-
derschlagsverteilung)

• modelReal und modelSzenV: enthal-
ten für die beiden Szenarien jeweils 
drei Raster-Datensätze (Zellengröße 
1x1 m): DGM; Beregnungsraster (mit 
räumlich verteilten Niederschlagswer-
ten); Raster mit Rauigkeitsbeiwerten.

 Die Raster werden im Modell „DataPro-
cAllVar“ standardmäßig direkt in den 
Ordner „FloodArea_Input“ geschrieben 
und können danach manuell je nach 
Bedarf in Unterordner verschoben wer-
den.

FloodArea_Output Dateiordner • modelReal

    → output

         → o0001.tif

         → o0002.tif

         → o0003.tif

         → o0004.tif

    → preprocessing.txt

• modelSzenV

• temp

Ergebnisraster der Berechnung der 
Überschwemmungsbereiche im Geo-
Tiff-Format;

Die Raster o0001.tif – o0004.tiff stel-
len jeweils die Wassertiefen zu einem 
bestimmten Zeitpunkt dar; hier nach 1,
2, 3 und 4 Stunden;

Die Raster werden automatisch im 
Ordner „output“ gespeichert (analog 
im Ordner modelSzenV); die txt-Datei 
enthält das Protokoll des Preproces-
sing;

der Ordner „temp“ stellt das Arbeits-
verzeichnis für FloodArea dar (nach 
erfolgreicher Berechnung leer).

ArcMap_Lyr Dateiordner • DGM_EZGK.lyr Layer-Dateien zu den Datensätzen, 
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• DGM_EZGMS.lyr

• DKM_LN_EZGMS_Klass.lyr

• FA_WT_EZGK

• FA_WT_SzenV

• FlGew_EZGMS.lyr

• Geb_EZGK.lyr

• HSG_EZGMS.lyr

• Inca_EZGK_3hMax.lyr

• Inca_EZGMS_24hSum.lyr

• Rauigkeit_EZGK.lyr

• S2A_LN_EZGK.lyr

• S2A_LN_EZGK_SzenV.lyr

• S2A_LN_EZGMS.lyr

• S2A_TrainGeb.lyr

• SCHUMM_EZGK.lyr

• SCHUMM_EZGMS.lyr

• UMGR_EZG_Koppl.lyr

• UMGR_EZG_Mondsee.lyr

• UMGR_SzenV.lyr

• VGL_LN_S2A_DKM.lyr

• VGL_WT_real_SzenV.lyr

die in der Master-Thesis als Abbildun-
gen und/oder Karten verwendet wer-
den;

Datenquelle ist jeweils der Datensatz 
in der FGDB „VisMetData“.

Sentinel.gdb FileGeodatabase • Product

• T33UUP_20170829_BOA10
m

• S2A_TrainGeb

• S2A_Klass

• S2A_LN

• S2A_LN_SzenV

„Product“ ist der Raster-Katalog, der 
zur Auswahl und zur Vorbereitung des
Downloads der Sentinel-Daten dient;

T33UUP_* ist die als Raster-Dataset 
integrierte ausgewählte Satellitenbild-
szene;

Die „S2A“-Daten enthalten die Trai-
ningsgebiete („_TrainGeb“, shape-For-
mat), das daraus klassifizierte Raster-
Dataset („_Klass“) und das mit den 
Werten der Landnutzung reklassifizier-
te Raster-Dataset („_LN“); 
S2A_LN_SzenV stellt die Landnut-
zung des Modellszenerios mit zusätzli-
cher Versiegelung dar.

BasicData.gdb FileGeodatabase • DGM

• Geb

• UMGR_EZG

Die Geobasisdaten, die neben der 
Landnutzung, den HSG und den Nie-
derschlagsdaten für die Modellierung 
benötigt werden:

• Digitales Geländemodell (DGM, Ras-
ter-Dataset)

• Gebäudeumrisse (Geb, shape-For-
mat)

• Umgrenzung des Einzugsgebiets 
(UMGR_EZG, shape-Format)

Für die vorliegende Modellierung sind 
die benötigten Geodaten zentral in der 
FGDB „BasicData“ abgelegt; das Mo-
dell ist aber so angelegt, dass die Da-
ten auch aus verschiedenen Quellen (je
nach vorhandenem Datenbestand) in 
das Modell importiert werden können.

PluvMod.gdb FileGeodatabase • IncaPointData_EPSG4326

    → IncaPoints20180608

• CN_EZG_LNreal

Die FGDB „PluvMod“ bildet den zen-
tralen Kern der Modellierung der Floo-
dArea-Input-Daten mittels Py-
thon-Skript-Werkzeug und ModelBuil-
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• CN_EZG_SzenV

• DGM_Geb_EZG

• EZG

• HSG_EZG

• Inca_EZG_3hMax

• IncaEff_EZG_3hMax_LNre-
al

• IncaEff_EZG_3hMax_LNS-
zenV

• IncaR1hMax

• IncaR3hMax

• IncaR6hMax

• IncaR24hSum

• LN_EZG_real

• LN_EZG_SzenV

• Rauigkeit_EZG_LNreal

• Rauigkeit_EZG_LNSzenV

der;

das Feature-Dataset 
„IncaPointData_EPSG4326“ bildet den
Container für die mittels Skript-Werk-
zeug „IncaCsvToPoint“ importierten 
Inca-Niederschlagsdaten, die dann als
Point-Feature-Class vorliegen; Koordi-
natensystem der Feature-Class ist das
GCS WGS 84 (EPSG 4326);

Anschließend erfolgt mittels Model-
Builder-Modell „IncaPointToRaster“ 
die Raster-Bildung und Importierung 
der Niederschlagsdaten für die statisti-
schen Werte 1h-, 3h- und 6h-Maxi-
mum und 24h-Summe (Datensätze 
„IncaR*“; dabei erfolgt auch die Proji-
zierung der Daten auf das gewählte 
Koordinatensystem, hier das PCS 
WGS 84 UTM Zone 33N (EPSG 
32633);

die übrigen Ausgangsdaten werden 
mittels ModelBuilder-Modell „DataPro-
cAllVar“ in die FGDB importiert und  
auf das im Modell gewählte Koordina-
tensystem projiziert, hier das PCS 
WGS 84 UTM Zone 33N;

zudem werden hier (mit Ausnahme 
von reinen temporären Daten) die Da-
tensätze gespeichert, die im Zuge der 
Modellierung mit „DataProcAllVar“ be-
rechnet und erstellt werden;

bis auf die Inca-Punkt-Feature-Class 
und die Umgrenzung des EZG (Poly-
gon-Feature-Class) liegen alle Daten 
als Raster-Datasets im ESRI-Grid-For-
mat vor.

Standardmäßig werden alle im Modell 
berechneten Datensätze immer mit 
dem Suffix „_EZG“ gespeichert (also 
z.B. „LN_EZG“ für die auf das gewähl-
te Einzugsgebiet zugeschnittene 
Landnutzung); Bei nachfolgend durch-
geführten Modell-Varianten müssen 
die betroffenen vorhandenen Daten-
sätze zunächst manuell umbenannt 
werden, damit die neuen Datensätze 
wieder unter dem allgemeinen Kürzel 
gespeichert werden können etc.; dies 
erfolgte hier bzgl. der veränderten 
Landnutzung im Szenario „SzenV“;

Die Ausgabedaten, die im letzten 
Schritt in das GeoTiff-Format umge-
wandelt werden, das als Input für Floo-
dArea benötigt wird, sind hervorgeho-
ben (Speicherung im Ordner „FloodA-
rea_Input“):

• DGM_Geb_EZG (DGM)

• Rauigkeit_EZG_* (Rauigkeitsbeiwer-
te)

• IncaEff_EZG_* (Effektiver Nieder-
schlag)

VisMetData.gdb FileGeodatabase • DGM_EZGK

• DGM_EZGMS

• DKM_LN_EZGMS

Datensätze, die in Abbildungen und 
Karten sowie in der Methodik-Darstel-
klung (auch außerhalb der eigentli-
chen Modellbildung) im Rahmen der 
Master-Thesis verwendet werden;
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• DKM_LN_EZGMS_Diss

• DKM_LN_EZGMS_Klass

• FA_WT_EZGK

• FA_WT_EZGK_SzenV

• FlGew_EZGMS

• Geb_EZGK

• HSG_EZGMS

• Inca_EZGK_1hMax

• Inca_EZGK_3hMax

• Inca_EZGK_6hMax

• Inca_EZGK_24hSum

• Inca_EZGMS_1hMax

• Inca_EZGMS_3hMax

• Inca_EZGMS_6hMax

• Inca_EZGMS_24hSum

• Rauigkeit_EZGK

• S2A_LN_EZGK

• S2A_LN_EZGK_SzenV

• S2A_LN_EZGMS

• S2A_TrainGeb

• SCHUMM_EZGK

• SCHUMM_EZGMS

• UMGR_EZG_Koppl

• UMGR_EZG_Mondsee

• UMGR_SzenV

• VGL_LN_S2A_DKM

• VGL_WT_Real_SzenV

bei den Datensätzen handelt es sich 
zum Teil um Duplikate oder Teilberei-
che der Ausgangsdaten mit bestimm-
tem räumlichen Zuschnitt (z.B. Land-
nutzung) oder mit bestimmtem zeitli-
chen Ausschnitt (z.B. Niederschlag); 

außerdem um Datensätze, die nur für 
den Methodik-Teil benötigt werden 
(z.B. Validierung der Landnutzung 
durch Vergleich S2A mit DKM);

außer den selbsterklärenden Bezeich-
nungen der Datensätze, sind die fol-
genden Erläuterungen zu nennen:

• DKM_LN_EZGMS_Diss: DKM-Land-
nutzungsdaten, zusammengeführt 
nach den 6 relevanten Klassen (sha-
pe-Format)

• DKM_LN_EZGMS_Klass: Raster-Da-
taset mit den 6 relevanten Klassen

• VGL_LN_S2A_DKM: Raster-Dataset 
zum Vergleich der S2A- und DKM-
Landnutzungs-Daten

• SCHUMM_: aus DGM berechnetes 
Schummerungs-Raster-Dataset zur 
Visualisierung des Geländereliefs

PluvMod.tbx Toolbox • IncaCsvToPoint

• IncaPointToRaster

• DataProcAllVar

• DataProcLNVar

• DataProcIncaVar

ArcMap-Tollbox mit:

• Python-Skript-Werkzeug „IncaCsvTo-
Point“ zur Datenaufbereitung und Um-
wandlung der Inca-CSV-Daten in eine
Punkt-Feature-Class mit Berechnung 
der entsprechenden statistischen 
Werte und anschließendem Import in 
Feature-Dataset der FGDB „PluvMod“

• ModelBuilder-Modell „IncaPointTo-
Raster“ zur Berechnung mehrerer 
Raster für je ein statistisches Maß 
ausgehend von der Inca-Punkt-Fea-
ture-Class

• ModelBuilder-Modelle „DataProcAll-
Var“ und zusätzliche Varianten „Data-
ProcLNIncaVar“ und „DataProcInca-
Var“ zur automatisierten Geodaten-
verarbeitung verschiedener Aus-
gangsdaten zu FloodArea-Input-Da-
ten   

UNIGIS_MSc_PluvMo-
d.mxd

ArcMap-Document - ArcMap-Kartendokument (Version 
10.6.1) als Arbeitsumgebung der Mo-
dellierung und zur Kartenerstellung

 * Daten ohne „sbgl“-Kennung müssen aus Original-Ordner entfernt werden; s. Kap. 3.4.4

Quelle: Eigene Zusammenstellung.
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3.5.2  Koordinaten-Referenzsystem des Modells

Die Inca-Niederschlagsdaten liegen nach Erstellung der Punkt-Feature-Class aus den CSV-Da-

ten mittels Python-Skript-Werkzeug „IncaCsvToPoint“ im geographischen Koordinatensystem

WGS 84 (EPSG 4326) vor. Im Modell „IncaPointToRaster“ muss das projizierte Koordinaten-

system angegeben werden, in dem die weitere Modellierung stattfinden soll (hier WGS 84 UTM

Zone 33N, EPSG 32633).

Die HSG-Daten liegen originär ebenfalls im geographischen Koordinatensystem WGS 84 vor.

Das im Modell „DataProcAllVar“ angegebene Ausgabe-Koordinatensystem bezieht sich auf die

Projizierung der HSG-Daten in das in der Modellierung verwendete PCS. Hier muss also das

gleiche PCS angegeben werden wie im Modell „IncaPointToRaster“.

Für alle weiteren Eingabe-Datensätze (DGM, Geb, UMGR_EZG) wird vorausgesetzt, dass sie

in dem PCS vorliegen, in dem die Modellierung stattfinden soll.

3.5.3  Python-Skript-Werkzeug IncaCSVToPoint und ModelBuilder-Modell 
IncaPointToRaster

Das Python-Skript „PyScr_INCA_CsvToPoint“ ist als Skript-Werkzeug „IncaCsvToPoint“ der

Toolbox „PluvMod“ hinzugefügt. Bei der Erstellung des Python-Skript-Werkzeugs müssen die

Parameter in derselben Reihenfolge festgelegt werden, wie sie im Skript mit dem Befehl „arc -

py.GetParameterAsText“ abgefragt werden. Die wichtigsten Erläuterungen zum Python-Skript-

Werkzeug sind in der Elementbeschreibung angegeben (s. Anhang E).

Das  Python-Skript-Werkzeug  liest  nacheinander  die  Inca-Regenradar-Datensätze  eines  Ver-

zeichnisses ein (24 Stunden-Zeitraum, CSV-Format, Dateien in 5-Minuten-Schritten in der Ein-

heit 1/100 mm pro km²) und erstellt eine Punkt-Feature-Class in der FGDB „PluvMod“ im Fea-

ture-Dataset „IncaPointData_EPSG4326“.  Die Niederschlagswerte werden dabei jeweils über

eine Stunde aufsummiert  und in ein entsprechendes Attributfeld der Punkt-Feature-Class ge-

schrieben. Anschließend werden das 1h-Maximum, 3h-Maximum und 6h-Maximum sowie die

24h-Summe des Niederschlags berechnet und jeweils in ein eigenes Attributfeld geschrieben.

Die Ausgabe-Punkt-Feature-Class  enthält  weiterhin Niederschlagswerte  in  der  Einheit  1/100

mm pro km², sie liegen im geographischen Koordinatensystem WGS 84 (EPSG 4326) vor. Er-

läuterungen zu den einzelnen Verarbeitungsschritten befinden sich als Kommentare im Python-

Skript (s. Anhang B).

Ausgehend von der so erstellten Punkt-Feature-Class wird im ModelBuilder-Modell „IncaPoint-

ToRaster“ für die berechneten statistischen Werte (1h-Maximum, 3h-Maximum, 6h-Maximum,

24h-Summe) je ein Raster-Dataset erstellt. Dafür wird die Punkt-Feature-Class zunächst auf ein

gewähltes PCS projiziert (hier WGS 84 UTM Zone 33N, EPSG 32633), danach über lineare In-

terpolation ein TIN erzeugt. Schließlich wird aus dem TIN ein Raster mit einer Zellengröße von

10 x 10 m erstellt und die Niederschlagswerte werden durch '100' geteilt,  so dass sie nun in der

Einheit mm pro 100 m² vorliegen.

Detaillierte Informationen zum ModelBuilder-Modell können dem Modell selbst (Anhang E)

und dem zugehörigen Modell-Bericht (xml-Format, Anhang D) entnommen werden. Die fol-

gende Abbildung zeigt den Aufbau in ModelBuilder.
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Abbildung 24: ModelBuilder-Modell IncaPointToRaster

Die nachfolgende Tabelle fasst die wichtigsten Informationen kurz zusammen: Eingangs- und

Ausgangsdaten, die verwendeten Werkzeuge und besonders zu beachtende Einstellungen.

Tabelle 8: Zusammenfassung ModelBuilder-Modell IncaPointToRaster

 Eingabedaten Werkzeuge Ausgabedaten

Punkt-Feature-Class (P):

IncaPoints20180608

[Räumliche Auflösung 1x1 km, EPSG 
4326, Einheit  1/100 mm]

• Projizieren

• TIN erstellen 1)

• TIN in Raster 2)

• Resampling 3)

• Divide 4)

Raster-Datasets in FGDB Pluv-
Mod:

IncaR1hMax

IncaR3hMax

IncaR6hMax

IncaR24hSum

[Auflösung/Zellengröße 10x10m,   
EPSG32633, Einheit mm]

 Eingabe-Koordinatensystem:

 GCS_WGS_1984 (EPSG4326)

Ausgabekoordinatensystem (P):

WGS_1984_UTM_Zone_33N 
(EPSG32633)

(P): Modellparameter (bei Modell-Ausführung durch Benutzer auszuwählen)

1) Die Variable „Ausgabekoordinatensystem“ muss auch bei „TIN erstellen“ nochmal angegeben werden. Die Projekti-
on der Daten muss obligatorisch vor der TIN-Erstellung erfolgen, da TIN mit geographischen Koordinaten nicht funktio-
niert. Als Höhenfeld wird das gewünschte statistische Maß angegeben, z.B. Max3h; Typ: Mass_Points; Tag-Feld wie 
Höhenfeld. Das jeweils nachfolgende Werkzeug „TIN erstellen“ wird mittels „Vorbedingung“ erst erstellt, wenn das vor-
hergehende Raster erstellt ist, da immer wieder auf den selben Ausgangsdatensatz zurückgegriffen werden muss.

2) Ausgabedatentyp: FLOAT; Methode: LINEAR

3) Ausgabezellengröße: 10x10; Resampling-Methode: BILINEAR

4) Konstanter Teilungswert: 100

3.5.4  ModelBuilder-Modelle DataProcAllVar, DataProcLNVar und DataPro-
cIncaVar

Das ModelBuilder-Modell „DataProcAllVar“ dient dazu, aus den Basis-Eingangsdaten Gelän-

de, Gebäude, Niederschlag, Landnutzung und hydrologischer Bodengruppe drei Rasterdatensät-

ze zu erstellen, die als Eingangsdaten für die Berechnung von Überschwemmungsbereichen mit

FloodArea verwendet werden können: Gelände, effektiver Niederschlag und Rauigkeitsbeiwer-

te.  Dafür  werden das  DGM mit  den  Gebäuden kombiniert,  die  Geländerauigkeiten aus  der

Landnutzung abgeleitet, hydrologische Bodengruppen herangezogen und der effektive Nieder-

schlag mittels Curve-Number-Verfahren berechnet.
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Detaillierte Informationen zum ModelBuilder-Modell können dem Modell selbst (Anhang E)

und dem zugehörigen Modell-Bericht (xml-Format, Anhang D) entnommen werden. Die fol-

gende Abbildung zeigt den Aufbau in ModelBuilder.

Abbildung 25: ModelBuilder-Modell DataProcAllVar

Die nachfolgende Tabelle fasst die wichtigsten Informationen kurz zusammen: Eingangs- und

Ausgangsdaten, die verwendeten Werkzeuge und besonders zu beachtende Einstellungen.

Tabelle 9: Zusammenfassung ModelBuilder-Modell DataProcAllVar

 Eingabedaten Werkzeuge Ausgabedaten

Eingabe-Features Umgrenzung 
Einzugsgebiet (P):

UMGR_EZG

[EPSG 32633]

• Features kopieren 1)

• Raster kopieren 1)

• Raster projizieren

• Ausschneiden Rechteck 2)

• Ausschneiden Geometrie 2)

• Resampling 2) 3)

• Feld hinzufügen

• Feld berechnen

• Feature in Raster

• Raster berechnen DGM+Geb 
4)

• Reklassifikation nach   ASCII-
Datei

• Kombinieren

• Lookup

• Raster berechnen IncaEff

Raster-Datasets in FGDB Pluv-
Mod:

DGM_Geb_EZG

[Räumliche Auflösung 1x1 m, EPSG 
32633; vertikales Koordinatensystem 
WGS 1984; Einheit m]

LN_EZG

Rauigkeit_EZG

HSG_EZG

CN_EZG

Inca_EZG

IncaEff_EZG

[Räumliche Auflösung 1x1 m, EPSG 
32633]

GeoTiff in Ordner FloodArea_In-
put:

FA_DGM

FA_Rauigkeit

FA_IncaEff

[Räumliche Auflösung 1x1 m, EPSG 
32633]

Eingabe-Raster DGM 1m (P):

DGM

[Räumliche Auflösung 1x1 m, EPSG 
32633; vertikales Koordinatensystem 
WGS 1984; Einheit m]

Eingabe-Features Gebäude (P):

Geb

[EPSG 32633]

Eingabe-Raster Landnutzung (P):

S2A_LN

[Räumliche Auflösung 10x10 m, 
EPSG 32633]

Eingabe-Raster Hydrologische 
Bodengruppen:

Hydrologic_Soil_Group

[Räumliche Auflösung 1x1 km, EPSG 
4326]

Ausgabekoordinatensystem (P):

WGS_1984_UTM_Zone_33N 
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(EPSG32633)

Eingabe-Raster Inca (P):

IncaR3hMax

[Räumliche Auflösung 10x10 m, 
EPSG 32633]

(P): Modellparameter (bei Modell-Ausführung durch Benutzer auszuwählen)

1) Daten aus externen Quellen (in diesem Fall aus der FGDB BasicData) werden im ersten Schritt in die FGDB Pluv-
Mod kopiert, damit anschließend mit einheitlichen Bezeichnungen weitergearbeitet werden kann und damit die Be-
rechnungen in einer FGDB stattfinden können; im letzten Schritt werden die Raster-Datasets der FGDB in das Geo-
Tiff-Format kopiert, das als Input für FloodArea benötigt wird. Zudem muss hier nochmal über die Umgebungseinstel-
lungen „Verarbeitungsausdehnung“ und „Fangraster“ sichergestellt werden, das die Raster über eine exakt identische
Zellenausrichtung verfügen. Außerdem wird der Pixelwert wie folgt angegeben: Für FA_DGM und FA_IncaEff 
32_BIT_FLOAT, für FA_Rauigkeit 32_BIT_UNSIGNED.

2) Die mehrfach angewandte Abfolge der Werkzeuge Ausschneiden Rechteck – Resampling – Ausschneiden Geome-
trie ist in ihrer Reihenfolge wichtig und stellt den effizientesten Weg für das Anpassen der Datensätze auf das EZG 
dar: bei direktem Ausschneiden auf die EZG-Geometrie können bei großen Rasterzellenweiten (niedrige räumliche 
Auflösung) „Lücken“ im EZG entstehen; andererseits nimmt ein Resampling der Gesamtdaten unnötig viel Rechenzeit 
und Speicherkapazität in Anspruch.

3) Resampling erfolgt bei diskreten Daten (Landnutzung, HSG) mit der Methode Nearest Neighbour, bei kontinuierli-
chen Daten (Niederschlag) mit der Methode Bilinear

4) Die Addition der beiden Raster DGM und Geb muss über zwei Schritte erfolgen: Die Umwandlung der Gebäu-
de-Features in ein Ratser-Dataset muss mit den Umgebungseinstellungen „Verarbeitungsausdehnung“ und „Fangras-
ter“ (DGM) erfolgen. Das Ausgaberaster enthält standardmäßig nur Werte im Bereich der Eingabe-Features. Aufgrund
der Umgebungseinstellungen wird das Gebiet der Verarbeitungsausdehnung außerhalb der Eingabefeatures mit 
NULL-Werten ausgefüllt. Im zweiten Schritt kann dann die MapAlgebra-Operation mit dem Operator Con (Conditional) 
durchgeführt werden: Wo das Gebäude-Raster NULL-Werte aufweist, bleibt das ursprüngliche DGM erhalten, wo das 
Gebäude-Raster Höhenwerte aufweist, werden die beiden Raster DGM und Gebäude addiert.

Über „Vorbedingungen“ wird geregelt, dass der jeweils erste Verarbeitungsschritt eines Eingabedatensatzes erst dann
erfolgt, wenn die für die weitere Verarbeitung benötigten anderen Datensätze vorher erstellt worden sind. Somit wird 
ein geregelter Ablauf des Gesamtmodells sichergestellt.

Hinsichtlich der Ausgabedaten erfolgt eine einheitliche und standardisierte Bezeichnung der im

Modell erstellten Daten und Zwischendaten, da somit für bestimmte Werkzeuge (z.B. Kombina-

tion HSG und LN) eine Automatisierung ohne zusätzliche Eingaben möglich ist. Da aus diesem

Grund bewusst auf eine Parametrisierung (d.h. Benutzer-Eingabe) der Ausgangsdaten verzichtet

wurde, müssen die Ausgabedaten vor etwaigen zusätzlichen Modell-Ausführungen manuell um-

benannt werden.  Bei der vorliegenden Modellierung wurde dies mit  den Suffixen „3hMax“,

„LNreal“ und LNSzenV“ durchgeführt.

Die beiden Modelle „DataProcLNVar“ und „DataProcIncaVar“ stellen zwei Varianten des Mo-

dells  „DataProcAllVar“  dar,  die  es  ermöglichen,  zusätzliche  Modell-Läufe  mit  veränderter

Landnutzung oder Niederschlagsszenario durchzuführen, ohne alle Datensätze noch einmal neu

berechnen zu müssen. Hierbei sind die o.g. Bezeichnungs-Modalitäten zu beachten.

Das Modell „DataProcLNVar“ verwendet die im Modell „DataProcAllVar“ erstellten Datensät-

ze DGM_Geb_EZG und HSG_EZG sowie einen bereits vorhandenen Datensatz zum Nieder-

schlag (Inca_EZG oder evtl.  umbenannt) und erlaubt die Verwendung von veränderten bzw.

neuen Datensätzen zur Landnutzung.  Die Raster-Datasets LN_EZG, Rauigkeit_EZG, CN_EZG

und IncaEff_EZG werden neu berechnet, die Input-Raster für FloodArea werden komplett neu

erstellt.

Die Ergebnisdaten aus dem Modell „DataProcAllVar“ sollten vor der Ausführung von „Data-

ProcLNVar“  entsprechend  mit  einem  eindeutigen  Suffix  gespeichert  werden  (z.B

LN_EZG_SzenA), da die Ergebnisdaten dieses Modells wieder unter den Standard-Bezeichnun-
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gen (LN_EZG, Rauigkeit_EZG, CN_EZG und IncaEff_EZG) gespeichert werden. Bestehende

Input-Raster für FloodArea müssen vorher ebenfalls umbenannt oder in ein anderes Verzeichnis

verschoben werden.

Abbildung 26: ModelBuilder-Modell DataProcLNVar

Das Modell „DataProcIncaVar“ verwendet den im Modell „DataProcAllVar“ erstellten Daten-

satz DGM_Geb_EZG sowie die bereits aus der Landnutzung abgeleiteten vorhandenen Daten-

sätze zur Rauigkeit und zum CN-Wert (Rauigkeit_EZG, CN_EZG oder evtl. umbenannt) und

erlaubt  die  Verwendung  von  neuen  Datensätzen  zum  Niederschlag.  Das  Raster-Dataset

IncaEff_EZG wird neu berechnet, die Input-Raster für FloodArea werden komplett neu erstellt.

Die Ergebnisdaten aus dem Modell „DataProcAllVar“ sollten vor der Ausführung von „Data-

ProcIncaVar“  entsprechend  mit  einem  eindeutigen  Suffix  gespeichert  werden  (z.B

IncaEff_EZG_3hMax_LNreal), da die Ergebnisdaten dieses Modells wieder unter der Standard-

Bezeichnung (IncaEff_EZG) gespeichert werden. Bestehende Input-Raster für FloodArea müs-

sen vorher ebenfalls umbenannt oder in ein anderes Verzeichnis verschoben werden.

Detaillierte Informationen zu den ModelBuilder-Modellen können den Modellen selbst (Anhang

E) und den zugehörigen Modell-Berichten (xml-Format, Anhang D) entnommen werden.
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3.6  Berechnung der Überschwemmungsbereiche mit FloodArea

Bei FloodArea handelt es sich um ein komplett in ArcGIS integriertes 2D-Modell zur hydrody-

namischen Berechnung von Überschwemmungsflächen, das quasi den Mittelweg darstellt zwi-

schen GIS-basierter und hydrodynamischer Modellierung. Das Abflussvolumen zur nächstgele-

genen Rasterzelle wird mit der Fließformel nach Manning-Strickler berechnet. Neben Zufluss-

ganglinien (fluviale Prozesse) kann auch eine flächige Beregnung in Form eines räumlich varia-

blen Rasters als Input eingebracht  werden, was im vorliegenden Modell Anwendung findet.

Weiterhin besteht die Möglichkeit, die räumlich variable Oberflächenrauigkeit sowie zusätzli-

che Parameter wie Fließhindernisse oder Durchlässe zu berücksichtigen. Der Output erfolgt in

Form von Rasterdaten, die entweder die absolute Höhe oder die Überschwemmungstiefe reprä-

sentieren. Da es in FloodArea keine Einschränkungen bzgl. der räumlichen Auflösung gibt, kön-

nen wichtige Geländeinformationen wie beispielsweise Mulden beibehalten werden, wodurch

die Genauigkeit der Ergebnisse verbessert werden kann (Geomer 2017, Tyrna et al. 2018). 

Wichtig vor dem Start von FloodArea ist der folgende allgemeine Hinweis (Geomer 2017): Die

Region des Computers bzw. des Benutzers, von dem aus FloodAreaHPC-Desktop benutzt wird,

muss auf Englisch eingestellt sein. Dies verhindert insbesondere bei der Benutzung von ArcGIS

Version 10.4 oder höher Punkt-Komma Problematiken. FloodAreaHPC-Desktop benutzt Punkte

als Trennzeichen bei Zahlen. Dies muss auch bei der Erstellung der Ganglieniendatei beachtet

werden!

3.6.1  GeoTiff-Raster und Gangliniendatei

Als Eingangsdaten für die Berechnung der Überschwemmungsbereiche mit FloodArea werden

die folgenden drei mit Hilfe von ModelBuilder erstellten Rasterdatensätze verwendet:

• FA_DGM.tif

• FA_IncaEff.tif

• FA_Rauigkeit.tif

Bei den Rasterdatensätzen handelt es sich um das digitale Geländemodell, das Beregnungsraster

mit Werten des effektiven Niederschlags und ein Raster mit Rauigkeitsbeiwerten nach Strickler.

Die Rasterdatensätze müssen zwingend im GeoTiff-Format vorliegen, außerdem muss sicherge-

stellt sein, dass die Raster über eine exakt identische Zellenausrichtung verfügen, d.h. die identi-

sche Zellengröße, identische Anzahl an Spalten und Zeilen und den identischen Raster-Ursprug

aufweisen. Das wird im letzten Werkzeug-Schritt (Raster kopieren) im ModelBuilder-Modell

durch die Umgebunseinstellungen „Verarbeitungsausdehnung“ und „Fangraster“ erreicht. Au-

ßerdem wird in diesem Werkzeug der Pixelwert  der Ausgaberaster  wie folgt festgelegt: Für

FA_DGM und FA_IncaEff '32_BIT_FLOAT',  für  FA_Rauigkeit  '32_BIT_UNSIGNED'.  Das

Raster mit den Rauigkeitsbeiwerten muss zwingend als 32 BIT-Raster mit Pixeltyp INTEGER

vorliegen (UNSIGNED entspricht dem Typ INTEGER ohne Vorzeichen). Hinsichtlich der an-

deren beiden Raster gibt es keine vergleichbaren Einschränkungen, die gewählten Pixeltypen

haben sich aber in der Praxis als tauglich erwiesen.

Zum Start von FloodArea wird in der in ArcMap integrierten FloodArea-Toolbar die Funktion

„Überschwemmungsbereiche  berechnen“  ausgewählt.  In  dem sich  öffnenden  Dialog-Fenster
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wird als Berechnungsmethode „Beregnung“ ausgewählt. Hier werden nun in den Feldern „Ge-

ländemodell“, „Beregnungsfläche“ und „Fließrauigkeit“ die entsprechenden o.g. Rasterdatensät-

ze (Ordner: FloodArea_Input > modelReal) ausgewählt:

Abbildung 28: FloodArea-Eingabe-Dialog-Fenster Rasterdaten

Bei Auswahl der entsprechenden Rasterdatensätze im Dialog-Fenster werden diese automatisch

dem geöffneten ArcMap-Kartendokument hinzugefügt.

Zudem muss  im Feld Beregnungsganglinie eine Gangliniendatei  im *.txt-Format  angegeben

werden, in der pro angegebenem Zeitschritt die Einspeisung des Niederschlags in das Modell

erfolgt.  Die  Gangliniendatei  kann  in  jedem  beliebigen  Texteditor  erstellt  werden.  Im

„Regelfall“,  der  im Anwenderhandbuch  beschrieben  wird,  wird  die  Niederschlagsmenge  in

mm/h über die Gangliniendatei  angegeben. Dadurch wird es ermöglicht, den zeitlichen Verlauf

eines Niederschlagsereignisses abzubilden. Das Beregnungsraster ermöglicht zudem die räumli-

che Gewichtung des Niederschlags. Dazu werden die Werte der Ganglinie mit den Werten des

Niederschlagsrasters multipliziert (Geomer 2017).

In dem in dieser Arbeit erstellten Datenmodell liegen jedoch die Niederschlagswerte selbst als

räumlich verteiltes Raster vor. Da sich Starkregenereignisse gerade auch durch ihre kleinräumli-

che Variabilität auszeichnen, ist der Informationsgehalt der räumlichen Niederschlagsverteilung

über das Beregnungsraster von großer Bedeutung für eine angepasste Modellierung. Der Regel-

fall wird daher „umgedreht“, so dass die Niederschlagswerte selbst im Beregnungsraster enthal-

ten sind und die Gewichtung dafür in der Ganglinie erfolgt. Da der Niederschlagszeitraum des

3h-Maximums im vorliegenden Fall als zeitlicher Block betrachtet wird, in dem die berechnete

Niederschlagsmenge in mm pro m² angegeben wird, hat die Ganglinie die folgende Gestalt, wo-

bei in der linken Spalte die Zeitabschnitte aufgelistet sind und in der rechten Spalte die Einspei-
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sung bzw. der Multiplikationsfaktor. Zwischen den Zeitschritten wird durch FloodArea automa-

tisch interpoliert.

Abbildung 29: FloodArea Eingabe-Ganglinie

Zwischen dem Anfang der Modellierung (Zeitpunkt 0.00) und dem Ende nach drei Stunden

(Zeitpunkt 3.00) wird zu jedem betrachteten Zeitpunkt des 3-stündigen Ereignisses genau die

Niederschlagsmenge in das Modell eingespeist, die im Beregnungsraster für die jeweilige Zelle

angegeben ist (Faktor 1.00). Im letzten Zeitabschnitt (Zeitpunkt 3.0001 bis Zeitpunkt 4.00) wird

kein Niederschlag mehr eingespeist, dieser Zeitraum dient dazu, dass sich der modellierte Ab-

fluss noch im Modellraum verteilen kann.

Entsprechend der erstellten Ganglinie wird im zweiten Dialogfenster von FloodArea die Mo-

delldauer eingestellt.

Abbildung 30: FloodArea-Eingabe-Dialog-Fenster Berechnungsangaben

Die Berechnungsdauer wird auf vier Stunden eingestellt, jede Stunde soll ein Ausgaberaster er-

stellt  werden. Zudem müssen in diesem Dialog die beiden Verzeichnisse für die temporären

FloodArea-Daten und die Ausgaberaster angegeben werden, außerdem, ob der Output in absolu-

ten Höhenwerten oder in Überschwemmungstiefen (hier gewählt) erfolgen soll.
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Die Eingaben zur Legende sind in diesem Fall ohne Relevanz, da die Visualisierung der Output-

Daten in ArcMap anschließend auf die Verteilung der Ergebnisdaten angepasst werden kann

und muss. Mit der Funktion „Berechnen“ wird die Modellierung schließlich gestartet.9

3.6.2  Überschwemmungsbereiche Realzustand

Die folgende Abbildung zeigt das Simulationsergebnis für die Niederschlagsmenge des 3h-Ma-

ximums am 8. Juni 2018 (s. auch Anhang A). Die berechneten Überschwemmungsflächen zei-

gen die Wassertiefen am Ende der vierten Stunde. Das Wasser im Modellgebiet hatte also nach

Niederschlagsende noch eine Stunde Zeit, sich ohne zusätzlichen Niederschlags-Input zu vertei-

len.

Abbildung 31: Berechnete Wassertiefen der Überschwemmungsbereiche im EZG Koppl für die 

Niederschlagsmenge des 3h-Maximums am 8. Juni 2018

Datengrundlage der Hintergrundkarte: basemap.at (www.geoland.at // www.basemap.at)

Zur besseren Visualisierung sind bei den Abbildungen der Wassertiefen jeweils die Wassertie-

fen bis 0,005 m (5 mm) von der Darstellung ausgeschlossen. Das gesamte EZG wäre ansonsten

mit einem geschlossenen Wasserfilm überzogen, der größtenteils Tiefen unterhalb 5 mm auf-

weist, was für die Betrachtung von Überschwemmungsflächen keine relevante Wassertiefe dar-

stellt. 

Die  ermittelten Überschwemmungsbereiche zeigen deutlich die  Abflussbahnen,  die  im EZG

Koppl bei einem Starkregenereignis zu erwarten sind. Die größten Wassertiefen bis über 1 m

9 Für das gewählte EZG mit einer Größe von ca. 6 km² und der gewählten Berechnungsdauer von vier Stunden er-
gab sich sich eine Modellierungszeit von ca. 10-12 Stunden (System: Intel i5 3.00 GHz, 16 GB RAM, Windows 7
Professional 64 Bit).
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finden sich erwartungsgemäß in den natürlichen Senken und Gräben bzw. Fließgewässerbetten

in der freien Landschaft, hier vor allem entlang des Nesselgrabens und des Plainfelder Bachs.

Es ist aber zudem erkennbar, dass auch die Straßen als bevorzugte Abflussbahnen dienen, wenn

auch größtenteils mit geringeren Wassertiefen unterhalb 10 cm. Größere Wassertiefen finden

sich entlang der Verbindungsstraße L107 (Wiestalstraße), wobei hier sicherlich der parallel ver-

laufende Plainfelder Bach von Bedeutung ist. Eine besondere Rolle spielt der Salzburgring im

so genannten Nesselgraben zwischen Koppl und Plainfeld, in dem sich große Wassertiefen erge-

ben, was allerdings vermutlich in der Realität so nicht eintreten würde, da am Salzburgring ent -

sprechende Entwässerungssysteme zu erwarten sind, die aber in der Modellierung nicht berück-

sichtigt worden sind.

Was die Überschwemmungsbereiche innerhalb der Siedlungsflächen angeht, finden sich Berei-

che mit relevanten Wassertiefen über 10 cm vor allem in den Ortsteilen Unterkoppl, Habach

und Rettenbachschwand. Auch im übrigen Gebiet befinden sich höhere Wassertiefen zum Teil

in direkter Randlage zu bebauten Flächen (z.B. westlich Willischwandt), was ebenfalls ein er -

höhtes Risiko darstellt.

3.6.3  Szenario mit zusätzlicher Versiegelung (SzenV)

3.6.3.1   Manipulation der Eingangsdaten

Zur  Veränderungen  des  Versiegelungsgrads  wird  eine  Reklassifizierung  der  S2A-Landnut-

zungsdaten durchgeführt. Dafür wird eine Maske benutzt, innerhalb derer alle aktuell bestehen-

den Werte (1-Versiegelt, 2-Rohboden, 3-Acker, 4-Grünland, 5-Wald) der Klasse mit dem Wert

'1' (Versiegelt) zugeordnet werden.

Die  Umgrenzung  der  „Versiegelungsmaske“  ist  orientiert  an  einer  Abgrenzung  von  Cori-

ne-Land-Cover-Daten (CLC), die das Ortsgebiet von Koppl, Schnurn und Willischwandt zu-

sammenfasst als „Discontinuous urban fabric“ (CLC-Code 112). Im hier entwickelten SzenV

wird die Fläche in ein Gebiet mit kompletter Versiegelung überführt, die folgende Abbildung

zeigt die Landnutzung innerhalb des EZG Koppl mit der Umgrenzung des SzenV-Gebietes:
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Abbildung 32: Landnutzung im EZG Koppl mit Umgrenzung Szenario SzenV

Die Verarbeitung muss analog zur Herstellung des DGM mit Gebäudeblöcken in zwei Schritten

durchgeführt werden. Zunächst wird das Gebiet innerhalb der Maske „UMGR_SzenV“ reklassi-

fiziert (Spatial Analyst Tools > Reklassifizieren; Umgebungseinstellungen > Raster-Analyse >

Zellengröße wie Eingangs-Layer,  Maske: UMGR_SzenV, Verarbeitungsausdehnung wie Ein-

gangs-Layer),  das  Ausgabe-Dataset  wird „S2A_LN_EZGK_temp“  genannt.  Die Angabe der

Verarbeitungsausdehnung ist dabei wichtig, damit das Ausgaberaster in den nicht neu-klassifi-

zierten Bereichen den Wert 'No Data' zugewiesen bekommt. Dies wiederum ist Voraussetzung

für die anschließende Raster-Berechnung. Diese erfolgt mit dem Werkzeug „Raster berechnen“

und  mit  Conditional-„Con“-Ausdruck  (Spatial  Analyst  Tools  >  Map  Algebra:

Con(IsNull("S2A_LN_SzenV_temp"),"S2A_LN_EZGK","S2A_LN_SzenV_temp")). In den Berei-

chen, in denen „S2A_LN_SzenV_temp“ keine Daten aufweist (IsNull), werden die ursprüngli-

chen Daten von „S2A_LN_EZGK“ verwendet, ansonsten werden die ursprünglichen Daten mit

den neuen Daten überschrieben. Das Ergebnis stellt sich wie folgt dar:
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Abbildung 33: Landnutzung Szenario SzenV im EZG Koppl

3.6.3.2   Auswirkung auf Überschwemmungsbereiche

Die folgende Abbildung zeigt das Simulationsergebnis für die Niederschlagsmenge des 3h-Ma-

ximums am 8. Juni 2018 mit veränderter Landnutzung gemäß Szenario SzenV. 
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Abbildung 34: Berechnete Wassertiefen der Überschwemmungsbereiche im EZG Koppl für die 

Niederschlagsmenge des 3h-Maximums am 8. Juni 2018 im Szenario SzenV

Datengrundlage der Hintergrundkarte: basemap.at (www.geoland.at // www.basemap.at)

Auf den ersten Blick sind keine großen Veränderumgen hinsichtlich der Ausdehnung der Über-

schwemmungsbereiche oder der Wassertiefen im Vergleich zum modellierten Realzustand er-

kennbar.

Zur Analyse, wie sich die zusätzlichen Versiegelungen auf die Wassertiefen auswirken, werden

die Wassertiefen der ursprünglichen Simulation mittels Map Algebra-Operation von den Was-

sertiefen der Simulation des Szenarios SzenV abgezogen (Spatial Analyst Tools > Map Algebra

> Raster berechnen: FA_WT_EZGK_SzenV - FA_WT_EZGK), so dass ein Raster entsteht, das

die Differenz der Wassertiefen enthält (VGL_WT_real_SzenV).
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Abbildung 35: Veränderung der Wassertiefen in den Überschwemmungsbereichen bei 

Szenario SzenV

Die Bereiche mit den stärksten Zunahmen der Wassertiefen ergeben sich entlang des Nesselgra-

bens, besonders östlich von Willischwandt und im westlichen Bereich des Salzburgrings. Zum

Teil finden sich auch Bereiche, in denen eine leichte Abnahme der Wassertiefen zu beobachten

ist. In den meisten Fällen (vor allem im Bereich des Salzburgrings) sind diese Flächen jedoch

durchmischt mit Flächen, in denen gleichzeitig ein Anstieg der Wassertiefe in der gleichen Grö-

ßenordnung zu erkennen ist. Das lässt darauf schließen, dass hier kleinräumige Variabilität im

Geländemodell den Ausschlag gibt, in welchen Zellen das Wasser schließlich gesammelt wird.

Hier kann nicht von einer validen Abbildung der Realität ausgegangen werden.

Zum Teil finden sich die Flächen mit leichtem Wassertiefen-Rückgang jedoch auch im Bereich

Koppl-Unterkoppl,  in dem die zusätzlichen Versiegelungen vorgenommen worden sind.  Der

Grund hierfür könnte sein, dass das Wasser,  das hier  in der Modellierung der Realsituation

größtenteils nur mit geringen Tiefen vorhanden war, über die zusätzlich versiegelten Flächen

schneller abfließt und sich zum betrachteten Zeitpunkt nach vier Stunden daher weniger Wasser

auf den Flächen selbst sammelt. 

In diesem Zusammenhang lässt sich die generelle Feststellung machen, dass sich die größten

negativen Veränderungen mit  erhöhten Wassertiefen nicht dort ergeben, wo die zusätzlichen

Versiegelungen erfolgt sind, sondern in den tiefer liegenden Gebieten (z.B. westlich von Wil -

lischwandt). Es ist zu vermuten, dass sich die erhöhten Versiegelungen vor allem bei niedrige-

ren Wassertiefen mehr auf die unterliegenden Flächen auswirken. Bei noch stärkeren Nieder-

schlägen mit noch höheren Wassertiefen werden auch die Gebiete mit erhöhten Versiegelungen

selbst einer höheren Gefährdung unterliegen.
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4.  Ergebnisdiskussion

4.1  Eignung der verwendeten Datengrundlage

Ein hoch aufgelöstes DGM und Gebäudeumriss-Daten sind die Grundvoraussetzung für eine

aussagekräftige Analyse von Überschwemmungsgebieten im Siedlungsraum. Mit den heute ver-

fügbaren Daten (insbesondere durch Fernerkundung mittels LiDAR) liegen solche Geländemo-

delle fast flächendeckend vor. Anders gestaltet es sich bei hoch aufgelösten Bodendaten, die für

viele Gebiete nicht oder nicht flächendeckend kartiert und verfügbar sind. Oftmals muss daher

auf sehr kleinmaßstäbige geologische oder Boden-Übersichtskarten (M 1:50.000 oder noch klei-

ner) zurückgegriffen werden. Anschließend muss dann aus den darin enthaltenen oft spärlichen

Informationen auf die Versickerungsfähigkeit des Oberbodens geschlossen werden. Aus diesem

Grund  wurde  für  die  Erstellung  des  Datenmodells  auf  die  weltweit  verfügbare  Datenbasis

HiHydroSoil zurückgegriffen. Die hier verfügbaren Rasterdaten sind mit einer räumlichen Auf-

lösung von 1x1 km vergleichbar mit  den für viele Gebiete ausschließlich verfügbaren Über-

sichtskarten, bieten aber den großen Vorteil, dass die Versickerungseigenschaften nicht erst auf-

wendig hergeleitet werden müssen, sondern in Form der klassifizierten hydrologischen Boden-

gruppen (A-D) direkt zur Verfügung stehen. Die hydrologischen Bodengruppen werden über

ein komplexes Rechenverfahren ermittelt, das eine Vielzahl an relevanten Parametern berück-

sichtigt. Gleichzeitig steht allerdings außer Frage, dass diese Daten aufgrund ihrer räumlichen

Auflösung stark generalisiert und nicht in der Lage sind, kleinräumige Variabilität des Bodenar-

tenspektrums abzubilden. Dafür bietet der Aufbau des Datenmodells die Möglichkeit, jederzeit

und durch geringe Veränderungen räumlich hoch aufgelöste Bodendaten zu verwenden, sofern

diese für das gewählte EZG verfügbar sind. 

Die aus den frei verfügbaren Sentinel 2A-Satellitenbilddaten mittels pixelbasierter Bildklassifi-

zierung abgeleitete Landnutzung weist eine hohe Qualität auf, die sich für das vorliegende Da-

tenmodell sehr gut eignet. Auch kleinere unversiegelte Bereiche wie Grünflächen innerhalb von

Siedlungsgebieten lassen sich gut identifizieren, was zur Qualitätsverbesserung der gesamten

Hochwassersimulation beiträgt, da hier alle Einflussfaktoren (effektiver Niederschlag, Gelän-

derauigkeit) pixelbasiert verrechnet werden. Die Begrenzung auf insgesamt nur sechs Landnut-

zungsklassen schränkt das Modell für Gebiete mit außergewöhnlichen Nutzungen ein, garantiert

aber gleichzeitig, dass das Modell gut für die meisten besiedelten Gebiete mit ihrem jeweiligen

Umland übertragbar ist. Je größer zudem die Vielfalt an Landnutzungsklassen ist, desto größer

ist die Bandbreite an Varianten bei der Einteilung von räumlichen Einheiten in diese Klassen,

was wiederum die Vergleichbarkeit erschwert.

Die verwendeten Inca-Radardaten stellen aufgrund der Darstellung der flächendeckenden Nie-

derschlagsverteilung eine ideale Datenquelle für die vorliegende räumliche Analyse des lokalen

Regengeschehens dar. Die unterschiedliche Niederschlagsverteilung im Gesamt-EZG Mondsee

und Teil-EZG Koppl lässt sich sehr gut verdeutlichen. Zudem bieten die Daten neben der hohen

räumlichen auch eine hohe zeitliche Auflösung des Intensitätsverlaufes, was einen wichtigen

Faktor für die Berechnung der statistischen Werte darstellt.
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Die Verwendung des CN-Verfahrens zur Berechnung des effektiven Niederschlags birgt in Zu-

sammenhang mit den genannten wenigen Landnutzungsklassen vermutlich die größte Anfällig-

keit für Ungenauigkeiten im Modell. Eine differenzierte Betrachtung beispielsweise verschiede-

ner Waldformen oder Grünland-Bewirtschaftungs-Methoden ist nicht möglich. Da die CN-Wer-

te zum Teil große Bandbreiten innerhalb dieser zusammengefassten Klassen aufweisen, muss

die Zuordnung des CN-Wertes zur jeweiligen LN-Klasse durch Mittelwertbildung erfolgen. Da-

mit einher geht automatisch ein entsprechender Informationsverlust, was die tatsächliche Versi -

ckerungsleistung und Entstehung des direkten Abflusses anbelangt. Großer Vorteil der Methode

ist allerdings, dass sie zusammen mit den global verfügbaren Daten der hydrologischen Boden-

gruppen eine vollständige Automatisierung des Datenmodells erlaubt, ohne dass Tabellenwerte

manuell ausgelesen und zugeordnet werden müssen. Zugleich sind außer der Landnutzung und

den Niederschlagsdaten keine weiteren Eingangsdaten erforderlich.  Dadurch kann wiederum

eine sehr gute raumübergreifende Übertragbarkeit und Vergleichbarkeit des Modells sicherge-

stellt werden.

4.2  Eignung des verwendeten Modells

Die ArcMap-Arbeitsumgebung bietet ideale Voraussetzungen für die Aufbereitung der für die

Hochwassermodellierung  erforderlichen  Daten  mittels  Python-Skript-Werkzeug  und  Model-

Builder-Modellen.  Die  einfache  Integrierbarkeit  von  Python-Skripten  durch  Py-

thon-Skript-Werkzeuge  und die  integrierten  Werkzeuge  zur  Raster-Berechnung  spielen  eine

wichtige Rolle bei der Herstellung der für FloodArea benötigten Rasterdaten. Dass alle Aufbe-

reitungsschritte  in  einer  einheitlichen Arbeitsumgebung  ausgeführt  werden können,  bedeutet

eine große Vereinfachung hinsichtlich der Automatisierung der einzelnen Prozesse. 

FloodArea stellt  nicht  nur  für die  Simulation von fluvialen Hochwasserereignissen,  sondern

auch für die Berechnung von pluvialen Überschwemmungsbereichen ein mächtiges Werkzeug

dar. Trotz der relativ großen EZG-Größe von ca. 6 km² ermöglicht es eine hohe räumliche Auf-

lösung der Input-Daten (1x1 m). Durch die Form der Eingangsdaten mit Beregnungsraster und

Gangline wird eine hohe Flexibilität erreicht, um auf die räumliche und zeitliche Verteilung der

Niederschlagswerte einzugehen. Zudem ist es möglich, zusätzliche Informationen wie Gelän-

derauigkeit oder Fließhindernisse in die Modellierung einfließen zu lassen. 

Im vorliegenden Fall muss einschränkend muss festgehalten werden, dass sich die Abflussbil-

dung ausschließlich am natürlichen Geländerelief orientiert, da keinerlei künstliche Fließhinder-

nisse wie z.B. Quer-Verbauungen zum Hochwasserschutz oder andere abflussleitende Bauwer-

ke berücksichtigt worden sind. Der Verzicht auf derartige Informationen, die zu einem realisti-

scheren Modell führen würden, ist der Prämisse geschuldet, das Modell möglichst gut auf ver-

schiedenste Gebiete übertragbar zu machen. 

Dementsprechend ist  das  Ziel  der  hier  durchgeführten Analyse  zur  Identifizierung pluvialer

Überschwemmungsgebiete auch keine lokal- und einzelfallbezogene Hochwassersimulation, die

als  direkter  Handlungsleitfaden für  den vorbeugenden Hochwasserschutz  verstanden werden

kann. Vielmehr stellt sie ein Instrument dar, das es erlaubt, mit einer überschaubaren Menge an

Eingangsdaten, die zudem raumübergreifend und weitgehend kostenfrei zugänglich sind, einen

groben  Überblick  zu  bekommen,  wo  sich  in  einem ausgewählten  Einzugsgebiet  bei  einem

Starkregenereignis die am stärksten gefährdeten Bereiche befinden. 
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Hinsichtlich der verwendeten Ganglinie wäre eine mögliche Alternative, in der Gangliniendatei

den Mittelwert aus dem gewählten Beregnungsraster anzugeben und im Beregnungsraster pro

Zelle eine Gewichtung anzugeben, die als Quotient aus tatsächlichem Wert und Mittelwert zu

berechnen wäre. Für das gewählte statistische Ereignis des 3h-Maximums würde diese Variante

allerdings nur einen zusätzlichen (unnötigen) Berechnungsschritt im Modell bedeuten, da das

Ereignis zeitlich als ein Block betrachtet wird. Sinnvoll könnte die Variante evtl. eingesetzt wer-

den, wenn der zeitliche Verlauf über einen längeren Zeitraum stärker im Interesse der Betrach-

tung stehen sollte. So könnte im Beregnungsraster beispielsweise die räumliche Verteilung der

24h-Summe als Gewichtung eingebracht werden (wiederum als Quotient aus Wert und Mittel-

wert) und in der Ganglinie ein Verlauf über 24 Stunden dargestellt werden, wobei pro Stunde

der jeweilige Stundenmittelwert als Niederschlagswert angegeben wird.

4.3  Aussagekraft der identifizierten Überschwemmungsbereiche

Vergleicht man das Berechnungsergebnis mit der Meldung aus der ZAMG-Unwetterchronik für

den 8. Juni 2018, so muss konstatiert werden, dass das Modell das tatsächliche Ereignis vermut-

lich tendentiell unterschätzt. Das kann an der verwendeten Berechnungsmethode des effektiven

Niederschlags  mittels  CN-Verfahren  liegen.  Je  nach  Bodenbeschaffenheit  und  Bewirtschaf-

tungs-Methode nehmen die umliegenden Grünlandflächen in der Realität u.U. weniger Wasser

auf, als es das Modell annimmt, was in der Realität zu einem schneller einsetzenden direkten

Abfluss mit größeren Abflussmengen führen könnte. 

Zum anderen kann auch die Form der verwendeten Ganglinie das Ergebnis beeinflussen. Die

Einspeisung der Niederschlagsmenge über die Werte des  Niederschlagsrasters in Multiplikation

mit einer konstante von 1,0 stellt für die grundsätzliche Tauglichkeitsprüfung  des entwickelten

Datenmodells eine praktikable Lösung dar. Was die Anpassung der Ganglinie an einzelne Nie-

derschlagsereignisse anbelangt, gibt es in jedem Fall noch Verbesserungspotenzial, das in weite-

ren Fallstudien, in denen nicht die Entwicklung des Datenmodells im Vordergrund steht, son-

dern die konkrete Hochwassersimulation, weiter untersucht werden kann.

Gleiches gilt für die Berücksichtigung von Entwässerungssystemen und besonders von Fließ-

hindernissen, die für eine lokalspezifische Hochwasseranalyse in Hinblick auf die konkrete Ge-

fährdung einzelner Bereiche nicht unberücksichtigt bleiben sollten.

Das entwickelte Datenmodell kann demnach als Grundgerüst verstanden werden, das für nahezu

jedes  Einzugsgebiet  eine erste  grobe  Einschätzung pluvialer  Überschwemmungsbereiche  er-

laubt. Je nach Zielrichtung der Modellierung und je nach Verfügbarkeit von Daten und Informa-

tionen im EZG kann das Datenmodell weiterentwickelt, ergänzt und modifiziert werden, um so

besser an die reale Situation angepasst zu werden.

4.4  Ausblick

Das  hier  entwickelte  Datenmodell  ist  primär  auf  die  weitere  Verwendung  der  Daten  mit

FloodArea zugeschnitten. Andere Programme zur Hochwassermodellierung verwenden jedoch

gleiche oder ähnliche Ausgangsdaten, wodurch das Datenmodell mit ggf. leichten Modifizierun-

gen also auch in anderen Arbeitsumgebungen einsetzbar ist.
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In der vorliegenden Arbeit sollte als Teil-Ziel überprüft werden, ob die Bildklassifizierung auch

in einer GIS-Arbeitsumgebung mit ausreichender Qualität durchgeführt werden kann. Auch aus

diesem Grund sind für die Landnutzung Sentinel 2A-Satellitenbilder verwendet worden. Sollte

es aus einzelfallbezogenen Gründen sinnvoller sein, Landnutzungsdaten aus anderer Quelle zu

verwenden, so ist das Modell auch in dieser Hinsicht problemlos modifizierbar, die Landnut-

zungsdaten müssen als einzige Voraussetzung als Raster zur Verfügung gestellt werden. Glei-

ches gilt im Prinzip auch für die Niederschlagsdaten. 

Das Datenmodell weist also insgesamt eine hohe Flexibilität auf, was die Modifizierung bzw.

die Anpassung an einzelfallbezogene Erfordernisse anbelangt.

Die Modellierungsergebnisse können einerseits zur Nachbereitung vergangener pluvialer Hoch-

wasserereignisse verwendet werden, um die Wirkungszusammenhänge besser verstehen und um

betroffene  Bereiche  systematisch  analysieren  zu  können.  Sofern  Prognosedaten  zu  Nieder-

schlagsdaten vorliegen, z.B. durch Downscaling von globalen Klima-Projektionen, besteht eine

andere Möglichkeit in der Abschätzung von Gefährdungsbereichen unter bestimmten Szenarien.

Gerade hier liegt dann auch der Vorteil von automatisierten Modellen, die eine mehrfache Wie-

derholung unter Veränderung einzelner Parameter erlauben.
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Anhang

Anhang A: Karten (Druck-Version und USB-Stick)

Anhang B: Python-Skript und Werkzeug-Code-Blöcke (nur USB-Stick)

Anhang C: Python-Skript- und ModelBuilder-Ausführungs-Protokolle (nur USB-

Stick)

Anhang D: ModelBuilder-Berichte im xml-Format (nur USB-Stick)

Anhang E: Datenmodell „UNIGIS_MSc_Mod“ mit allen verwendeten und erstellten 
Daten sowie Toolbox mit Python-Skript-Werkzeug und ModelBuil-
der-Modellen (nur USB-Stick)
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Anhang A: Karten

Karte 1: Geländehöhen mit Schummerung und Gebäudeumrissen im EZG Koppl

Karte 2: Landnutzung klassifiziert nach Senntinel 2A im EZG Koppl (Realzustand)

Karte 3: Landnutzung klassifiziert nach Senntinel 2A im EZG Koppl (mit Veränderung nach 

Szenario SzenV)

Karte 4: Niederschlagsmenge 3-Stunden-Maximum des Starkregenereignisses vom 8.6.2018 im 

EZG Koppl

Karte 5: Simulierte Überschwemmungsbereiche des Starkregenereignisses vom 8.6.2018 (3h-

Max) im EZG Koppl (Realzustand)

Karte 6: Simulierte Überschwemmungsbereiche des Starkregenereignisses vom 8.6.2018 (3h-

Max) im EZG Koppl (nach Szenario SzenV)

Karte 7: Veränderung der Wassertiefen zwischen Realzustand und Szenario SzenV im EZG 

Koppl
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